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Disclaimer

The data, examples and diagrams in this manual are included solely for the concept or product
description and are not to be deemed as a statement of guaranteed properties. All persons responsible
for applying the equipment addressed in this manual must satisfy themselves that each intended
application is suitable and acceptable, including that any applicable safety or other operational
requirements are complied with. In particular, any risks in applications where a system failure and/or
product failure would create a risk for harm to property or persons (including but not limited to
personal injuries or death) shall be the sole responsibility of the person or entity applying the
equipment, and those so responsible are hereby requested to ensure that all measures are taken to
exclude or mitigate such risks.

This product has been designed to be connected and communicate data and information via a network
interface which should be connected to a secure network. It is the sole responsibility of the person
or entity responsible for network administration to ensure a secure connection to the network and
to take the necessary measures (such as, but not limited to, installation of firewalls, application of
authentication measures, encryption of data, installation of anti virus programs, etc.) to protect the
product and the network, its system and interface included, against any kind of security breaches,
unauthorized access, interference, intrusion, leakage and/or theft of data or information. ABB is not
liable for any such damages and/or losses.

This document has been carefully checked by ABB but deviations cannot be completely ruled out. In
case any errors are detected, the reader is kindly requested to notify the manufacturer. Other than
under explicit contractual commitments, in no event shall ABB be responsible or liable for any loss or
damage resulting from the use of this manual or the application of the equipment.

In case of discrepancies between the English and any other language version, the wording of the
English version shall prevail.



Conformity

This product complies with the directive of the Council of the European Communities on the
approximation of the laws of the Member States relating to electromagnetic compatibility (EMC
Directive 2014/30/EU) and concerning electrical equipment for use within specified voltage limits
(Low-voltage directive 2014/35/EU). This conformity is the result of tests conducted by the third party
testing laboratory Intertek in accordance with the product standard EN 60255-26 for the EMC directive,
and with the product standards EN 60255-1 and EN 60255-27 for the low voltage directive. The product
is designed in accordance with the international standards of the IEC 60255 series.



Safety information

Dangerous voltages can occur on the connectors, even though the auxiliary voltage has been
disconnected.

Non-observance can result in death, personal injury or substantial property damage.

Only a competent electrician is allowed to carry out the electrical installation.

National and local electrical safety regulations must always be followed.

The frame of the protection relay has to be carefully earthed.

The protection relay contains components which are sensitive to electrostatic discharge.
Unnecessary touching of electronic components must therefore be avoided.

Whenever changes are made in the protection relay, measures should be taken to avoid
inadvertent tripping.
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1 Introduction

1.1 This manual
The engineering manual contains instructions on how to engineer the protection
relays using the different tools in PCM600. The manual provides instructions on how
to set up a PCM600 project and insert relays to the project structure. The manual
also recommends a sequence for engineering of protection and control functions,
LHMI functions as well as communication engineering for IEC 61850 and other
supported protocols.

1.2 Intended audience
This manual addresses system and project engineers involved in the engineering
process of a project, and installation and commissioning personnel, who use
technical data during engineering, installation and commissioning, and in normal
service.

The system engineer must have a thorough knowledge of the application,
protection and control equipment and the configured functional logic in the relays.
The installation and commissioning personnel must have a basic knowledge of
handling electronic equipment.
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1.3 Product documentation

1.3.1 Product documentation set
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Quick installation guide
Brochure
Product  guide
Operation manual
Installation manual
Engineering manual
Technical manual
Application manual
Communication protocol manual
IEC 61850 engineering guide
Cyber security deployment guideline
Hardware modification instructions
Modification sales guideline

Figure 1: The intended use of documents during the product life cycle
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1.3.2 Document revision history

Document revision/
date

Product connectivity
level

History

A/2019-05-08 PCL1 First release

B/2020-02-13 PCL2 Content updated to correspond to the prod-
uct connectivity level

C/2020-12-09 PCL3 Content updated to correspond to the prod-
uct connectivity level

D/2023-02-13 PCL4 Content updated to correspond to the prod-
uct connectivity level

1.3.3 Related documentation
Name of the document Document ID

TISSUES Implementation Conformance Statement (TICS) for
the IEC 61850 interface in REX640 1MRS759027

Protocol Implementation extra Information for Testing (PIX-
IT) for the IEC 61850 interface in REX640 1MRS759030

Protocol Implementation extra Information for Testing (PIX-
IT) for the IEC 61850 9–2LE interface in REX640 1MRS759037

Protocol Implementation Conformance Statement (PICS) for
the IEC 61850 interface in REX640 1MRS759029

IEC 61850 Ed2 Model Implementation Conformance State-
ment (MICS) for REX640 1MRS759028

Download the latest documents from the ABB Web site www.abb.com/
mediumvoltage.

1.4 Symbols and conventions

1.4.1 Symbols
The caution icon indicates important information or warning related to
the concept discussed in the text. It might indicate the presence of
a hazard which could result in corruption of software or damage to
equipment or property.

The information icon alerts the reader of important facts and conditions.
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The tip icon indicates advice on, for example, how to design your project
or how to use a certain function.

Although warning hazards are related to personal injury, it is necessary to
understand that under certain operational conditions, operation of damaged
equipment may result in degraded process performance leading to personal injury
or death. Therefore, comply fully with all warning and caution notices.

1.4.2 Document conventions
A particular convention may not be used in this manual.

• Abbreviations and acronyms are spelled out in the glossary. The glossary also
contains definitions of important terms.

• Menu paths are presented in bold.

Select Main menu > Settings.
• Parameter names are shown in italics.

The function can be enabled and disabled with the Operation setting
• Parameter values are indicated with quotation marks.

The corresponding parameter values are "On" and "Off".
• Input/output messages and monitored data names are shown in Courier font.

When the function starts, the START output is set to TRUE.
• Values of quantities are expressed with a number and an SI unit. The

corresponding imperial units may be given in parentheses.
• This document assumes that the parameter setting visibility is "Advanced".
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1.4.3 Functions, codes and symbols
Table 1: Functions included in the relay

Function IEC 61850 IEC 60617 ANSI

Protection

Distance protection DSTPDIS Z< 21P,21N

Local acceleration logic DSTPLAL LAL 21LAL

Scheme communication logic DSOCPSCH CL 85 21SCHLGC

Current reversal and weak-end infeed logic CRWPSCH CLCRW 85 21CREV,WEI

Communication logic for residual overcurrent RESCPSCH CLN 85 67G/N
SCHLGC

Current reversal and weak-end infeed logic for residual overcur-
rent

RCRWPSCH CLCRWN 85 67G/N
CREV,WEI

Power swing detection DSTRPSB Zpsb 68

Line differential protection with inzone power transformer LNPLDF 3Id/I> 87L

Binary signal transfer BSTGAPC BST BST

Switch-onto-fault protection CVPSOF CVPSOF SOTF

Three-phase non- directional overcurrent protection, low stage PHLPTOC 3I> 51P-1

Three-phase non- directional overcurrent protection, high stage PHHPTOC 3I>> 51P-2

Three-phase non- directional overcurrent protection, instanta-
neous stage

PHIPTOC 3I>>> 50P

Three-phase directional overcurrent protection, low stage DPHLPDOC 3I>-> 67P/51P-1

Three-phase directional overcurrent protection, high stage DPHHPDOC 3I>>-> 67P/51P-2

Non-directional earth-fault protection, low stage EFLPTOC Io> 51G/51N-1

Non-directional earth-fault protection, high stage EFHPTOC Io>> 51N-2

Non-directional earth-fault protection, instantaneous stage EFIPTOC Io>>> 50G/50N

Directional earth-fault protection, low stage DEFLPDEF Io>-> 67G/N-1 51G/N-1

Directional earth-fault protection, high stage DEFHPDEF Io>>-> 67G/N-1 51G/N-2

Three-phase power directional element DPSRDIR I1 -> 67P-TC

Neutral power directional element DNZSRDIR I2->,Io-> 67N-TC

Admittance-based earth-fault protection EFPADM Yo>-> 21YN

Multifrequency admittance-based earth-fault protection MFADPSDE Io>->Y 67NYH

Wattmetric-based earth-fault protection WPWDE Po>-> 32N

Transient/intermittent earth-fault protection INTRPTEF Io>->IEF 67NTEF/NIEF

Harmonics-based earth-fault protection HAEFPTOC Io>HA 51NH

Touch voltage based earth-fault current protection IFPTOC IF>/UT> 46SNQ/59N

Negative-sequence overcurrent protection NSPTOC I2>M 46M

Table continues on the next page
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Function IEC 61850 IEC 60617 ANSI

Phase discontinuity protection PDNSPTOC I2/I1> 46PD

Residual overvoltage protection ROVPTOV Uo> 59G/59N

Three-phase undervoltage protection PHPTUV 3U< 27

Three-phase overvoltage variation protection PHVPTOV 3Urms> 59.S1

Three-phase overvoltage protection PHPTOV 3U> 59

Positive-sequence overvoltage protection PSPTOV U1> 59PS

Positive-sequence undervoltage protection PSPTUV U1< 27PS

Negative-sequence overvoltage protection NSPTOV U2> 47,59NS

Frequency protection FRPFRQ f>/f<,df/dt 81

Three-phase voltage-dependent overcurrent protection PHPVOC 3I(U)> 51V

Overexcitation protection OEPVPH U/f> 24

Three-phase thermal protection for feeders, cables and distri-
bution transformers

T1PTTR 3Ith>F 49F

Three-phase thermal overload protection, two time constants T2PTTR 3Ith>T/G/C 49T/G/C

Three-phase overload protection for shunt capacitor banks COLPTOC 3I>3I< 51,37,86C

Current unbalance protection for shunt capacitor banks CUBPTOC dI>C 60N

Three-phase current unbalance protection for shunt capacitor
banks

HCUBPTOC 3dI>C 60P

Shunt capacitor bank switching resonance protection, current
based

SRCPTOC TD> 55ITHD

Compensated neutral unbalance voltage protection CNUPTOV CNU> 59NU

Directional negative- sequence overcurrent protection DNSPDOC I2>-> 67Q

Low-voltage ride- through protection LVRTPTUV UU 27RT

Voltage vector shift protection VVSPPAM VS 78VS

Directional reactive power undervoltage protection DQPTUV Q>-> ,3U< 32Q,27

Reverse power/ directional overpower protection DOPPDPR P>/Q> 32R/32O

Underpower protection DUPPDPR P< 32U

Three-phase under impedance protection UZPDIS ZZ 21G

Directional negative sequence impedance protection DNZPDIS Z2-> Z2Q

Three-phase under excitation protection UEXPDIS X< 40

Third harmonic-based stator earth-fault protection H3EFPSEF dUo>/Uo3H 64TN

Rotor earth-fault protection (injection method) MREFPTOC Io>R 64R

Generator shaft leakage current GSLPTOC I>,GS 38, 51

Thermal overload protection for rotors RPTTR 3Ith>R 49R

High-impedance or flux-balance based differential protection MHZPDIF 3dIHi>M 87HIM

Out-of-step protection with double blinders OOSRPSB OOS 78PS

Negative-sequence overcurrent protection for machines MNSPTOC I2>M 46M

Table continues on the next page
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Function IEC 61850 IEC 60617 ANSI

Loss of phase, undercurrent PHPTUC 3I< 37

Loss of load supervision LOFLPTUC 3I< 37

Motor load jam protection JAMPTOC Ist> 50TDJAM

Motor start-up supervision STTPMSU Is2t n< 49,66,48,50TDLR

Motor start counter MSCPMRI n< 66

Phase reversal protection PREVPTOC I2>> 46R

Thermal overload protection for motors MPTTR 3Ith>M 49M

Stabilized and instantaneous differential protection for ma-
chines

MPDIF 3dl>M/G 87M/87G

Underpower factor protection MPUPF PF< 55U

Stabilized and instantaneous differential protection for two- or
three- winding transformers

TR3PTDF 3dI>3W 87T3

Stabilized and instantaneous differential protection for two-
winding transformers

TR2PTDF 3dI>T 87T

Numerical stabilized low-impedance restricted earth-fault pro-
tection

LREFPNDF dIoLo> 87NLI

High-impedance based restricted earth- fault protection HREFPDIF dIoHi> 87NHI

High-impedance differential protection for phase A HIAPDIF dHi_A> 87_A

High-impedance differential protection for phase B HIBPDIF dHi_B> 87_B

High-impedance differential protection for phase C HICPDIF dHi_C> 87_C

Circuit breaker failure protection CCBRBRF 3I>/Io>BF 50BF

Three-phase inrush detector INRPHAR 3I2f> 68HB

Master trip TRPPTRC Master Trip 94/86

Arc protection ARCSARC ARC AFD

High-impedance fault detection PHIZ HIF HIZ

Cable Fault Detection RCFD CFD CFD

Fault locator SCEFRFLO FLOC FLOC

Load-shedding and restoration LSHDPFRQ UFLS/R 81LSH

Multipurpose protection MAPGAPC MAP MAP

Accidental energization protection GAEPVOC U<,I> 50/27

Load blinder LBRDOB LB 21LB

Control

Circuit-breaker control CBXCBR I <-> O CB 52

Three-state disconnector control P3SXSWI I<->O P3S 29DS/GS

Disconnector control DCXSWI I <-> O DCC 29DS

Earthing switch control ESXSWI I <-> O ESC 29GS

Three-state disconnector position indication P3SSXSWI I<->O P3SS 29DS/GS

Table continues on the next page
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Function IEC 61850 IEC 60617 ANSI

Disconnector position indication DCSXSWI I <-> O DC 29DS

Earthing switch position indication ESSXSWI I <-> O ES 29GS

Motor controlled earthing switch and disconnector supervision ESDCSSWI ESDCCM 29CM

Emergency start-up ESMGAPC ESTART EST,62

Autoreclosing DARREC O->I 79

Autosynchronizer for generator breaker ASGCSYN AUTOSYNCG 25AUTOSYNCG

Autosynchronizer for network breaker ASNSCSYN AUTOSYNC 25AUTOSYNCBT/
T

Autosynchronizer co-ordinator ASCGAPC AUTOSYNC 25AUTOSYNC

Synchronism and energizing check SECRSYN SYNC 25

Tap changer control with voltage regulator OL5ATCC COLTC 90V

Transformer data combiner OLGAPC OLGAPC OLGAPC

Petersen coil controller PASANCR ANCR 90

High speed bus transfer HSABTC I<->O BT HSBT

Condition monitoring and supervision

Circuit-breaker condition monitoring SSCBR CBCM 52CM

Hot-spot and insulation ageing rate monitoring for transform-
ers

HSARSPTR 3Ihp>T 26/49HS

Trip circuit supervision TCSSCBR TCS TCM

Current circuit supervision CCSPVC MCS 3I CCM

Current circuit supervision for transformers CTSRCTF MCS 3I,I2 CCM 3I,I2

Current transformer supervision for high- impedance protec-
tion scheme for phase A

HZCCASPVC MCS I_A CCM_A

Current transformer supervision for high- impedance protec-
tion scheme for phase B

HZCCBSPVC MCS I_B CCM_B

Current transformer supervision for high- impedance protec-
tion scheme for phase C

HZCCCSPVC MCS I_C CCM_C

Fuse failure supervision SEQSPVC FUSEF VCM, 60

Protection communication supervision PCSITPC PCS PCS

Runtime counter for machines and devices MDSOPT OPTS OPTM

Three-phase remanent undervoltage supervision MSVPR 3U<R 27R

Diesel Generator Monitoring DGMGAPC P><,U/f >< 32/40G

Measurement

Three-phase current measurement CMMXU 3I IA, IB, IC

Sequence current measurement CSMSQI I1, I2, I0 I1, I2, I0

Residual current measurement RESCMMXU Io IG

Three-phase voltage measurement VMMXU 3U VA, VB, VC

Single-phase voltage measurement VAMMXU U_A V_A

Table continues on the next page
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Function IEC 61850 IEC 60617 ANSI

Phase voltage measurement VPHMMXU 3UL VL

Residual voltage measurement RESVMMXU Uo VG/VN

Sequence voltage measurement VSMSQI U1, U2, U0 V1, V2, V0

Three-phase power and energy measurement PEMMXU P, E P, E

Load profile recorder LDPRLRC LOADPROF LOADPROF

Frequency measurement FMMXU f f

Tap changer position indication TPOSYLTC TPOSM 84T

Power quality

Current total demand, harmonic distortion, DC component
(TDD, THD, DC) and individual harmonics

CHMHAI PQM3IH PQM ITHD,IDC

Voltage total harmonic distortion, DC component (THD, DC)
and individual harmonics

VHMHAI PQM3VH PQM VTHD,VDC

Voltage variation PHQVVR PQMU PQMV
SWE,SAG,INT

Voltage unbalance VSQVUB PQUUB PQMV UB

Traditional LED indication

LED indication control LEDPTRC LEDPTRC LEDPTRC

Individual virtual LED control LED LED LED

Logging functions

Disturbance recorder (common functionality) RDRE DR RDRE

Disturbance recorder, analog channels 1...12 A1RADR A1RADR A1RADR

Disturbance recorder, analog channels 13...24 A2RADR A2RADR A2RADR

Disturbance recorder, binary channels 1...32 B1RBDR B1RBDR B1RBDR

Disturbance recorder, binary channels 33...64 B2RBDR B2RBDR B2RBDR

Fault recorder FLTRFRC FAULTREC FR

Other functionality

Parameter setting groups PROTECTION PROTECTION PROTECTION

Time master supervision GNRLLTMS TSYNC TSYNC

Serial port supervision SERLCCH SERLCCH SERLCCH

IEC 61850-1 MMS MMSLPRT MMS MMS

IEC 61850-1 GOOSE GSELPRT GSE GSE

IEC 60870-5-103 protocol I3CLPRT I3C I3C

IEC 60870-5-104 protocol I5CLPRT I5C I5C

DNP3 protocol DNPLPRT DNP 3.0 DNP 3.0

Modbus protocol MBSLPRT MBS MBS

OR gate with two inputs OR OR OR

OR gate with six inputs OR6 OR6 OR6

Table continues on the next page
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Function IEC 61850 IEC 60617 ANSI

OR gate with twenty inputs OR20 OR20 OR20

AND gate with two inputs AND AND AND

AND gate with six inputs AND6 AND6 AND6

AND gate with twenty inputs AND20 AND20 AND20

XOR gate with two inputs XOR XOR XOR

NOT gate NOT NOT NOT

Real maximum value selector MAX3R MAX3R MAX3R

Real minimum value selector MIN3R MIN3R MIN3R

Rising edge detector R_TRIG R_TRIG R_TRIG

Falling edge detector F_TRIG F_TRIG F_TRIG

Real switch selector SWITCHR SWITCHR SWITCHR

Integer 32-bit switch selector SWITCHI32 SWITCHI32 SWITCHI32

SR flip-flop, volatile SR SR SR

RS flip-flop, volatile RS RS RS

Minimum pulse timer, two channels TPGAPC TP 62TP

Minimum pulse timer second resolution, two channels TPSGAPC TPS 62TPS

Minimum pulse timer minutes resolution, two channels TPMGAPC TPM 62TPM

Pulse counter for energy measurement PCGAPC PCGAPC PCGAPC

Pulse timer, eight channels PTGAPC PT 62PT

Time delay off, eight channels TOFGAPC TOF 62TOF

Time delay on, eight channels TONGAPC TON 62TON

Daily timer DTMGAPC DTM DTM

Calendar function CALGAPC CAL CAL

SR flip-flop, eight channels, nonvolatile SRGAPC SR SR

Boolean value event creation MVGAPC MV MV

Integer value event creation MVI4GAPC MVI4 MVI4

Analog value event creation with scaling SCA4GAPC SCA4 SCA4

Generic control points SPCGAPC SPC SPCG

Generic up-down counter UDFCNT UDCNT UDCNT

Local/Remote control CONTROL CONTROL CONTROL

External HMI wake-up EIHMI EIHMI EIHMI

Real addition ADDR ADDR ADDR

Real subtraction SUBR SUBR SUBR

Real multiplication MULR MULR MULR

Real division DIVR DIVR DIVR

Table continues on the next page
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Function IEC 61850 IEC 60617 ANSI

Real equal comparator EQR EQR EQR

Real not equal comparator NER NER NER

Real greater than or equal comparator GER GER GER

Real less than or equal comparator LER LER LER

Voltage switch VMSWI VSWI VSWI

Current sum CMSUM CSUM CSUM

Current switch CMSWI CMSWI CMSWI

Phase current preprocessing ILTCTR ILTCTR ILTCTR

Residual current preprocessing RESTCTR RESTCTR RESTCTR

Phase and residual voltage preprocessing UTVTR UTVTR UTVTR

Residual current preprocessing, current measured as voltage RESUTCTR Io(U) Io(U)

SMV stream receiver (IEC 61850-9-2LE) SMVRCV SMVRCV SMVRCV

SMV stream sender (IEC 61850-9-2LE) SMVSENDER SMVSENDER SMVSENDER

Redundant Ethernet channel supervison RCHLCCH RCHLCCH RCHLCCH

Ethernet channel supervision SCHLCCH SCHLCCH SCHLCCH

HMI Ethernet channel supervision HMILCCH HMILCCH HMILCCH

Received GOOSE binary information GOOSERCV_BIN GOOSERCV_BIN GOOSERCV_BIN

Received GOOSE double binary information GOOSERCV_DP GOOSERCV_DP GOOSERCV_DP

Received GOOSE measured value information GOOSERCV_MV GOOSERCV_MV GOOSERCV_MV

Received GOOSE 8- bit integer value information GOOSERCV_INT8 GOOSERCV_INT8 GOOSERCV_INT8

Received GOOSE 32- bit integer value information GOOSERCV_INT32 GOOSERCV_INT32 GOOSERCV_INT32

Received GOOSE interlocking information GOOSERCV_INTL GOOSERCV_INTL GOOSERCV_INTL

Received GOOSE measured value (phasor) information GOOSERCV_CMV GOOSERCV_CMV GOOSERCV_CMV

Received GOOSE enumerator value information GOOSERCV_ENUM GOOSERCV_ENUM GOOSERCV_ENU
M

Bad signal quality QTY_BAD QTY_BAD QTY_BAD

Good signal quality QTY_GOOD QTY_GOOD QTY_GOOD

Received GOOSE Test mode QTY_GOOSE_TEST QTY_GOOSE_TEST QTY_GOOSE_TES
T

GOOSE communication quality QTY_GOOSE_COMM QTY_GOOSE_COM
M

QTY_GOOSE_COM
M

GOOSE data health T_HEALTH T_HEALTH T_HEALTH

Fault direction evaluation T_DIR T_DIR T_DIR

Enumerator to boolean conversion T_TCMD T_TCMD T_TCMD

32-bit integer to binary command conversion T_TCMD_BIN T_TCMD_BIN T_TCMD_BIN

Binary command to 32-bit integer conversion T_BIN_TCMD T_BIN_TCMD T_BIN_TCMD

Switching device status decoder - CLOSE position T_POS_CL T_POS_CL T_POS_CL

Table continues on the next page
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Function IEC 61850 IEC 60617 ANSI

Switching device status decoder - OPEN position T_POS_OP T_POS_OP T_POS_OP

Switching device status decoder - OK status T_POS_OK T_POS_OK T_POS_OK

Controllable gate, 8 Channels GATEGAPC GATEGAPC GATEGAPC

Security application GSAL GSAL GSAL

Hotline tag HLTGAPC HLTGAPC HLTGAPC

16 settable 32-bit integer values SETI32GAPC SETI32GAPC SETI32GAPC

16 settable real values SETRGAPC SETRGAPC SETRGAPC

Boolean to integer 32- bit conversion T_B16_TO_I32 T_B16_TO_I32 T_B16_TO_I32

Integer 32-bit to boolean conversion T_I32_TO_B16 T_I32_TO_B16 T_I32_TO_B16

Integer 32-bit to real conversion T_I32_TO_R T_I32_TO_R T_I32_TO_R

Real to integer 8-bit conversion T_R_TO_I8 T_R_TO_I8 T_R_TO_I8

Real to integer 32-bit conversion T_R_TO_I32 T_R_TO_I32 T_R_TO_I32

Constant FALSE FALSE FALSE FALSE

Constant TRUE TRUE TRUE TRUE
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2 Relay engineering process
PCM600 is used for various tasks in the protection relay engineering process.

• Relay engineering management

- Organizing the bay protection relays in the structure of the substation by
defining voltage levels and bays below the substation. PCM600 manages the
project.

- Configuring the protection relay functions (for example, protection and
control functions) by using Application Configuration.

- Configuring the parameters and setting values for the protection relay and for
the process functions by using Parameter Setting.

- Configuring LHMI pages, drawing single-line diagrams and making links to
dynamic process values by using Graphical Display Editor. The single-line
diagrams are displayed on the LHMI and the WHMI on the bay protection relay.

- Configuring connections between the application configuration function
blocks and physical hardware inputs and outputs by using Signal Matrix or
Application Configuration.

- Configuring the events shown on the LHMI using HMI Event Filtering.

• Communication management

- IEC 61850 station communication engineering is done using the internal IEC
61850 Configuration tool or the separate IET600. PCM600 interacts with
IET600 by importing and exporting SCL files.

- Configuring the GOOSE receiving data connections to the protection
relay's application configuration function blocks by using the Application
Configuration tool and the Signal Matrix tool.

- Configuring protocol data mapping for Modbus, DNP3, IEC 60870-5-103 or IEC
60870-5-104 with the Communication Management tool.

- Configuring the sampled values (process bus) between the devices using
Application Configuration, IEC 61850 Configuration and Signal Matrix.

- Configuring Ethernet ports and other network settings using Ethernet
Configuration.

• Record management

- Generating overviews of the available disturbance recordings in all connected
protection relays by using Disturbance Handling.

- Manually reading the recording files (in the COMTRADE format) from the
protection relays by using Disturbance Handling or automatically by using
PCM600 Scheduler.

- Managing recording files with Disturbance Handling.
- Creating overview reports for fast evaluation of the recording file content by

using Disturbance Handling.
- Reading fault records from the protection relay, saving records to a PC and

clearing old records with Fault Record.
- Reading load profile records from the protection relay, saving records to a PC

and clearing old records using Load Profile.

 

• Service management
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- Monitoring the selected signals of a protection relay for commissioning or
service purposes by using Application Configuration, Parameter Setting and
Event Viewer (including security logs)

There are also additional functions for managing projects and organizing user
rights.

• PCM600 user management

- Organizing users regarding their rights, profiles and passwords to use
different tools and functions in the tools.

- Defining allowed activities for user profiles to use tools in PCM600.

• Relay user management

- Supporting user account management and role-based access control
- Using IED Users for local user accounts and Account Management for central

account management

Once the engineering of the protection relay is finished, the results must be written
to the protection relay.

The connection between the physical IED and PCM600 is established via an Ethernet
link on the HMI or LAN port of the protection relay.

2.1 Monitoring and control system structure
The monitoring and control system can be divided into three main parts which
require specific engineering and configuration.

• Bay level devices
• Station communication
• Station level devices

IEC08000101.vsd

Bay level

Station level

Station
Communication

Station bus

bay
IED 1

bay
IED 2

bay
IED n-1

bay
IED n

NCC-GW
(station-IED2)

PCM600
(tool set)

HSI
(station-IED1)

Figure 2: Principle structure of a monitoring and control system for a substation

A plant structure is used to identify each device in its location within the substation
organization. The plant structure is a logical image of the substation and the bays
within the substation. The device organization may differ from the structure of the
primary equipment in the substation.
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In PCM600 it is possible to set up a hierarchical structure of five levels for the device
identification.

• Project
• Substation = name of the substation
• Voltage level = identifies to which grid type or part the device belongs in the

substation
• Bay = bay within the voltage level
• IED = selection of the IED that is used in the bay; several IEDs can be inserted in a

bay, for example, one control device and two protection relays

2.2 Default configuration
The protection relay contains a default configuration when delivered. The
default configuration contains a simple application configuration and an LHMI
configuration which can be used as a basis when the actual application
configuration is created for the protection relay installation. The default
configuration does not have output relays connected in the application
configuration, so the relay and its configuration must not be used in installation
as they are; modification of the application configuration is always required before
commissioning.

The default configuration is available for IEC 61850 Edition 2 only, though the relay
supports the IEC 61850 Edition 1 as well. For instructions on how to enable Edition 1
for the relay, see chapter IED insertion.
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2.3 Workflow

Make GOOSE connections

Export SCL files  
from PCM 600

Import SCL files to  
IET 600  and do 
signal engineering. 
Export updated 
SCL files from 

  
IET 600

Import SCL files 
600

Start

ACT
SMT

PST

GDE

SMT

CMT
ACT

Export
SCD

IET600

Import
SCD

IED
WRITE

End

Configure IED functionality

Parametrization

Signal engineering

Configure pages for local HMI

Save the work 
between the 

different steps

Project
Create plant structure and 
insert IED objects

IEC 61850
DNP3

IEC 60870-5-104

Write configuration to IED

IEC 61850
Configuration tool

to PCM

Modbus

IEC 60870-5-103

Figure 3: Protection relay engineering workflow proposal based on practical
experience and dependencies of the steps

It is possible to follow a different sequence based on the information available
at the start of the project. This means that several iterations may be needed to
complete the project.

PCM600 project setup

• The plant structure is built according to the substation structure.
• To add a protection relay to a project, a suitable connectivity package is needed.

Protection relays can be added either while connected or disconnected or
through other means such as an IED template.

• IED objects are uniquely named within the PCM600 project.

Application configuration in the Application Configuration tool

• Protection and control functions can be configured as needed.
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• The configuration made in Application Configuration is saved to make the
interfaces and signals available for other engineering tools within PCM600, for
example, for Parameter Setting.

Parameter setting and configuration in the Parameter Setting tool

• The setting values are checked and adjusted with the Parameter Setting tool.

HMI engineering in Graphical Display Editor

• It is possible to create new pages, configure pages by adding widgets, set page
visibility to different user categories, create single-line diagrams (shown on the
LHMI and the WHMI) and symbols, and to provide language translations for the
LHMI elements.

Communication protocol engineering

• The communication engineering details are protocol-dependent.
• The connectivity package creates the IEC 61850 configuration for vertical

communication automatically and it is often directly suitable for IEC 61850
client configuration. Either IEC 61850 Configuration tool or IET600 is needed for
configuring horizontal and vertical communication.

• The Communication Management tool is used for other protocols; for example
Modbus.

The protection relay restarts automatically when writing a relay
configuration where changes have been made. It is not possible to
communicate with the protection relay during restart.
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3 PCM600
Protection and Control IED Manager PCM600 offers all the necessary functionality
to work throughout all stages of the protection relay's life cycle.

• Planning
• Engineering
• Commissioning
• Operation and disturbance handling
• Functional analysis

The whole substation configuration can be controlled and different tasks and
functions can be performed with the individual tool components. PCM600 can
operate with many different topologies, depending on the project needs.

PCM600 is used to conduct complete engineering and configuration activities
needed for the bay-level protection relays.

Connectivity packages are separate software packages that provide type and
version information to PCM600 and assist the tool with communications.

PCM600 communicates with devices over Ethernet using either IEC 61850 or the
FTP/FTPS protocols. This communication allows PCM600 to configure and monitor
the devices. In addition to IEC 61850, the devices have optional communication
protocols and hardware to connect to station engineering tools. PCM600 provides
the ability to export the configuration of the devices or an entire substation in
a standard file format which enables station engineering in separate IEC 61850
system configuration tools.

A PC with PCM600 can be connected to any Relion protection relay within a station
by using the Ethernet connection. The connection can also be used for service
and maintenance purposes and to handle disturbance records from the protection
relays.

The modern protection relays are designed using the concept of the IEC 61850
standard. This is mainly visible in how functions within the protection relay are
modelled and how the protection relay is represented in the substation. The list of
logical nodes available in the protection relay reflects the IEC 61850 parameter list.
The logical nodes follow the structure and rules defined in part 7 of the standard.

The communication protocol engineering is a separate task and an addition to the
engineering of protection and control functions.

As PCM600 can be used for different purposes throughout the protection relay life
cycle, a set of tools is available for different applications.

The applications can be organized into groups.

• Relay engineering
• Communication engineering
• Record management
• Device monitoring and diagnostic
• User management
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For more information, see the PCM600 documentation.

3.1 Connectivity packages
A connectivity package is a software component that consists of executable code
and data which enable system tools to communicate with a protection relay.
Connectivity packages are used to create configuration structures in PCM600. The
latest PCM600 and connectivity packages are backward compatible with older
protection relay versions.

A connectivity package includes all the data which is used to describe the
protection relay. For example, it contains a list of the existing parameters, data
format used, units, setting range, access rights and visibility of the parameters.
In addition, it contains code which allows the software packages that use the
connectivity package to properly communicate with the protection relay.

3.2 PCM600 and relay connectivity package version
• Protection and Control IED Manager PCM600 Ver. 2.12 or later
• REX640 Connectivity Package Ver. 1.3.0 or later

Download connectivity packages from the ABB Web site www.abb.com/
mediumvoltage or directly with Update Manager in PCM600.

3.2.1 Installing connectivity packages
• Install connectivity packages either by running the installer which can be

downloaded on the ABB Web site or by using Update Manager when a network
connection is available.

Download connectivity packages from the ABB Web site www.abb.com/
mediumvoltage or directly with Update Manager in PCM600.

3.2.1.1 Installing connectivity packages by using the connectivity package
installer
1. Close PCM600.
2. Run the connectivity package installer.

- ABB IED Connectivity Package REX640 Ver. n.msi
- ABB IED Connectivity Package REX640 Ver. n. User Documentation.msi

(optional)

(n = version number)
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3. Follow the steps in the connectivity package installation wizard.

3.2.1.2 Installing connectivity packages by using Update Manager

1. In PCM600, click Help and select Update Manager.
Run Update Manager with administrator rights.

Figure 4: Running Update Manager as an administrator

2. Select Get Connectivity Packages from the menu on the left column.

3. Select all the required connectivity packages.
4. Click Download and Install.

The status bar shows the installation status.

Figure 5: Selecting the connectivity packages

3.2.2 Activating connectivity packages

The relay connectivity package has to be installed before it can be activated in
Update Manager.
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1. Select Manage Connectivity Packages from the menu on the left column to
access the installed connectivity packages.

2. Browse the tree structure to find the correct product.
3. Select the connectivity package version from the drop-down list beside the

product name.

Always use the latest version of the connectivity package.

Figure 6: Selecting the connectivity package versions

PCM600 recognizes the installed connectivity packages during start-up, and the
corresponding IED types are available in PCM600 when starting a new project.

3.3 PCM600 projects
A typical project in PCM600 contains a plant structure including one or several IED
objects, where each IED object contains the engineering data created or modified
using the different PCM600 tools.

Several projects can be created and managed by PCM600, but only one project can
be active at a time.

Regardless of the protocol used in installation for each project, it is possible to have
Edition1 and Edition2 relays configured in the same PCM600 project. The PCM600
project's SCL edition is the highest SCL edition relay in the project. If IEC 61850 is
not used for station bus, either version can be applied. The protection relay's IEC
61850 version is by default Edition 2.

With PCM600, it is possible to do various tasks.

• Open existing projects
• Import projects
• Create new projects
• Export projects
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• Delete projects
• Rename projects
• Copy and paste projects

The extension of the exported project file is .pcmp. The files are only used for
exporting and importing projects between PCM600s.

3.4 Technical key
Both a physical IED and an IED object in PCM600 have a technical key. The technical
key in the protection relay and PCM600 must be the same, otherwise it is not
possible to download a configuration.

Each IED in a PCM600 project and in an entire substation must have a unique
technical key. Therefore, it is not possible to set the same technical key for several
IEDs in the same PCM600 project.

The protection relay is delivered with a factory default technical key.
The validation of the technical keys between PCM600 and the protection
relay does not occur if the protection relay contains the factory default
technical key.

The technical key property in PCM600 corresponds to the IED name
attribute in SCL files. Avoid changing the IED name attribute outside
PCM600, because data in PCM600 may get lost when importing the SCL
files.

When writing a configuration to the protection relay, PCM600 checks for a
mismatch between the IED object and the physical IED technical key. The technical
key can be read from the protection relay and updated to PCM600, or the PCM600
technical key can be written to the protection relay. Alternatively, a user-defined
technical key can be defined.

Figure 7: Reboot suggestion

Ensure that the IED object in PCM600 has the same IP address as the
physical IED to be connected through the technical key.

Change the technical key for an IED object in the Object Properties
dialog box in PCM600.
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3.4.1 IEC 61850 naming conventions for an IED
The IEC 61850 naming conventions to identify an IED are valid only when the IEC
61850 standard is used for station bus communication. According to IEC 61850-6,
the SCL model allows two kinds of project designations in the object properties: a
technical key and a user-oriented textual designation.

• The technical key is used in engineering drawings and for signal identifications.
This is contained in the attribute name as an identification of each object. If
the value is used as a reference to an object, it is contained in an attribute
name starting with a string denoting the reference target object type and ending
with the string Name. The technical key is used within SCL for referencing other
objects. The name is a relative identification within a hierarchy of objects. The
maximum length of the technical key is 28 characters for Edition 1 and 60
characters for Edition 2.

• User-oriented textual designation is contained in the desc attribute. Attributes
are not allowed to contain carriage return, line feed, tab, greater than, less than,
double quotes or ampersand characters. The semantics of desc must also be
relative within an object hierarchy. The maximum length is 100.

PCM600 supports both possibilities. The two signal designations are available per
object in Object Properties for all the hierarchical levels beginning with the station
as the highest level.

The technical key is automatically generated based on the rules and type
specifications of IEC 61346 and the extended definitions assigned for substations
by a technical committee. The technical key is shown in the Object Properties dialog
box under SCL Technical Key or Technical Key.

• The station is predefined by “AA1" where 1 is the index. To get the real station
name that is used, it is possible to rename the SCL Technical Key for the station
as the name used by the project. To minimize the word length, a short form
should be used because this name is also used in the transmitted messages to
identify the events, for example.

• The voltage level. In Figure 8 it is 20 kV and J1 is selected from the list below SCL
Technical Key in the Object Properties dialog box.

• The bay and the IED are appended with the coding defined in the IEC 61346
standard and the substation definition lists. In the example, the bay SCL
Technical Key part is Q03 and IED is A1.

The user-oriented textual designation is visible in the Plant structure view for each
object. It is the name given by default or changed by with the Rename function.

Figure 8: IEC 61850 signal designation concept in PCM600
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The created technical key for the full path name of the IED would be: AA1J1Q03A1.

• AA1 = substation in the project
• J1 = voltage level from 20 to 30 kV
• Q03 = third bay in the voltage level
• A1 = first IED in bay Q03

3.4.2 Setting technical key

The maximum length of the technical key is 28 characters for Edition 1
and 60 characters for Edition 2.
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1. In the Plant Structure view, right-click the IED and select Set Technical Key in
IED.

Figure 9: PCM600: Setting the technical key on the IED level

A dialog box opens to inform about the technical key concept.
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Figure 10: Technical key information

2. Click OK.

The technical key is read from the IED and the Set Technical Key dialog box
opens.

Figure 11: Setting the technical key

3. In the Set Technical Key dialog box, select the technical key to be used. There
are three alternatives.

• Use the technical key in the IED
• Use the technical key defined for the IED object in PCM600
• Set a user-defined technical key, which changes the technical key for both

the physical IED and IED object in PCM600
4. Click OK to confirm the selection.

It is not possible to set a user-defined name or select Technical
key in IED if the value is already given to another IED object in the
PCM600 project. An error message is displayed if this happens.
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3.5 Communication between PCM600 and the
protection relay
The communication between the protection relay and PCM600 is independent of
the used communication protocol within the substation or to the NCC.

All communication is done over Ethernet using either IEC 61850 or the FTP/FTPS
protocol.

When an Ethernet-based station protocol is used, the same Ethernet port and IP
address can be used for PCM600 communication.

Two basic variants have to be considered for the connection between PCM600 and
the protection relay.

• Direct point-to-point link between PCM600 and service port X1.2 on the
protection relay's LHMI or, if an LHMI is not used, the HMI port X0 of the
communication module

• Indirect link via station LAN or remotely via network

1. If needed, the IP address for the protection relay is set.
2. A PC or workstation is set up for a direct link (point-to-point), or the PC or

workstation is connected to the LAN/WAN network.
3. The protection relays' IP addresses in the PCM600 project are configured to

match the IP addresses of the physical IEDs.
4. Technical keys of the IEDs in the PCM600 project are configured to match the

technical keys of the physical IEDs.

For successful protection relay engineering and usage, the workstation firewall TCP
and UDP port configurations should be checked, especially for IEC 61850 and FTP.
Other protocols are not used for engineering or they are optional.

3.5.1 Setting up IP addresses
The IP address and the corresponding subnet mask can be set via LHMI for the
Ethernet interface in the protection relay. Each Ethernet interface has a default
factory IP address when the protection relay is delivered. The configured Ethernet
interface IP address is preserved if the communication card is replaced.

1. Set the IP address for the protection relay's rear port and the corresponding
subnet mask via the LHMI paths Configuration > Communication > Ethernet >
Network1 address and Configuration > Communication > Ethernet > Network2
address.

Only the Network1 interface is enabled by default. See the cyber security
deployment guideline for more information.

Table 2: Default IP addresses for the LAN port interfaces and the correspond-
ing subnet masks

Interface IP address Subnet mask Default mode

Network1 192.168.2.10 255.255.255.0 Enabled

Network2 192.168.3.10 255.255.255.0 Disabled
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When using redundant Ethernet (HSR or PRP), configure all devices in the
network before connecting cables to ports LAN A and LAN B. Avoid using
the LAN A or LAN B ports on redundant communication modules while
changing the Switch mode parameter.

3.6 IED Update
The firmware update tool is used for updating the following:

• IED firmware
• HW module firmware
• LHMI firmware and application
• License in case of Modifications Sales related update

The tool can also be used for adding or replacing IED languages. Update packages
are provided by Customer Support.

The update tool can be used either locally or remotely.

Separate update packages are needed for updating the communication
card, the LHMI and license and default configuration files. If the new
communication card firmware, LHMI firmware or application need new
IED firmware, it is updated at the same time, otherwise a second update
with the same package is needed to update the IED firmware.

3.6.1 Prerequisites for local and remote updates
Local update

• It is recommended to use the LHMI’s service port X1.2 or, if an LHMI is not used,
the HMI port X0 of the communication module. The IED should be removed from
the network especially with redundant network topologies (HSR or PRP).

Remote update

• Communication should be secured either by setting up a VPN
connection or by enabling secure communication in the IED via LHMI
(Configuration > Communication > Protocols > Network1FTP or Configuration >
Communication > Protocols > Network2 > FTP).

• Remote update can be enabled in the IED either via the LHMI (Configuration >
Authorization > Security > Remote Update) or by an administrator in Parameter
Setting in PCM600 (IED Configuration > Configuration > Authorization >
Remote Update. If the IED is in local control mode, remote update proceeds only
after a confirmation is received from the user.

• Remote update can be disabled manually after the update.
• Remote update only works when the IED is connected from the Ethernet

interface connector of the communication module with a custom IP address.
• Remote update via a network gateway can be assigned either to Network 1 or

Network 2.
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3.6.2 Updating firmware or language
1. Select the update mode.

• Firmware
• Language

2. Select the update package and click Next.

Figure 12: Choosing the update mode and package
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3. Select the relay to be updated and click Next.

Currently only one relay can be selected.

Figure 13: Choosing the relay for the update
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4. If required, clear the life cycle handling indication by selecting the Clear
Lifecycle Handling indication on Local HMI after update check box.

Figure 14: Clearing lifecycle handling indication

5. When updating remotely, wait for 30 seconds for the local user confirmation
before proceeding with the update.

- The local user can cancel the update via the LHMI by pressing Cancel Update
during the 30-second window.

- IED use is allowed after the update is completed successfully.
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Figure 15: Waiting for local user confirmation with remote update

Figure 16: Completing the update
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4 Setting up a project

4.1 Creating a new project
1. Start PCM600.
2. To see the projects that are available in the PCM databases, click File and select

Open > Manage Project on the menu bar.
3. In the Open > Manage Project window, click Projects on my computer.
4. Click New Project.
5. If there are projects or object tools open, a confirmation dialog box opens.

Figure 17: Confirming project and object tool closing

6. In the Create New Project dialog box, fill in the project name and optional
description.

- In the Project Name box, type a unique name for the project.
- In the Description box, type a description of the project.
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Figure 18: Creating a new project

7. Click Create.

PCM600 sets up a new project that is listed under Projects on my computer.

4.2 Building plant structure
1. Create a new plant structure in one of the alternative ways.

• Right-click the Plant Structure view, point to New and select Create from
Template.

• Right-click the Plant Structure view, point to New, select General and select
either IED Group or Substation.

2. On the View menu, select Object Types.
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3. Select the needed elements and drag them into the plant structure.

Figure 19: Project with IEDs placed but not renamed

4. Rename each level in the structure by the names or identifications used in the
grid.

Use one of the alternative ways.

• Right-click the level and select Rename.
• Rename the levels in the Object Properties view.

4.3 IED insertion
The context menu or the Object Types view shows the available IEDs that can
be inserted on the bay level of the plant structure according to the installed
connectivity package.

It is possible to do various tasks in the plant structure.

• Insert either an offline or an online IED
• Import a template IED that is available in the template library as a .pcmt file
• Import a preconfigured IED available as a .pcmi file

PCM600 uses two kinds of IED files: .pcmt and .pcmi. Both files include
the complete IED configuration but their usage differs. The .pcmt files
are always accessed through the PCM600 template manager while
the .pcmi files are meant for sharing the IED instances between different
PCM600 users enabling quick import and export from the plant structure
context menu.
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4.3.1 Inserting an IED in online mode

To set up an IED online, the protection relay must be connected to PCM600.

When the protection relay is connected to PCM600, PCM600 can read the
composition code directly from the relay. It is possible to read the full configuration
from the relay by using the Read from IED function.

1. In the Plant Structure view, right-click the bay, point to New, point to the relay
application area such as Multiapplication IEDs and select the protection relay
type to be inserted.

Alternatively, drag an IED from the Object Types view to the bay
level.

Figure 20: Selecting the protection relay type
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2. On the Configuration mode selection page, select Online Configuration and
click Next.

Figure 21: Selecting the configuration mode
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3. On the Communication protocol page, select the communication protocol from
the IED Protocol list and click Next.

Figure 22: Selecting the communication protocol

4. On the IEC61850 communication protocol page, select the port from the Port
list.

• If the LAN port is selected, type the correct IP address (of the physical
protection relay to be configured) to the IP address box.
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Figure 23: Selecting the communication port and IP address

Communication configuration is now defined.
5. Click Next to scan/read the composition code of the protection relay.
6. On the Composition code detection page, click Next.

Figure 24: Detecting the composition code
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7. On the Configuration selection page, select the configuration type and click
Next.

• Select Empty Configuration to create an empty configuration.
• Select Import configuration from file (PCMI/PCMT) to import any existing

example configuration.

Click Browse to select the .pcmi or .pcmt file that has the example
configuration.

• Select Default configuration (available only for IEC 61850 Edition 2) to
generate a default configuration.

Figure 25: Selecting the configuration type

If a default configuration is selected, the next page is skipped as
default configuration is only supported for the IEC 61850 Edition
2 IEDs. To configure an IEC 61850 Edition 1 IED, select empty or
example configuration and make the proper selections on the next
page.
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8. On the Version Selection page, select the IEC 61850 version and click Next.

Figure 26: Selecting the IEC 61850 version

Regardless of the protocol used in the installation for each project,
it is possible to have Edition1 and Edition2 relays configured in the
same PCM600 project. The PCM600 project's SCL edition is the
highest SCL edition relay in the project.
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9. On the Summary page, click Finish to confirm the configuration and insert the
IED.

The Summary page shows the protection relay's IED type, IP address and the
selected composition code.

Figure 27: Confirming the configuration

If an error is shown on the Summary page, it is not possible to
go back and make modifications. If an error is detected, cancel the
insertion by clicking Cancel and insert the IED again.

4.3.2 Inserting an IED in offline mode
When the protection relay is not available or is not connected to PCM600,
engineering can be done offline. The offline configuration in PCM600 can be written
to the protection relay later when it is connected.

Working in the offline mode has an advantage over the online mode because the
preparation for the configuration can be started even though the protection relay is
not available.

1. In the Plant Structure view, right-click the bay, point to New, point to the relay
application area such as Multiapplication IEDs and select the protection relay
type to be inserted.

Alternatively, drag an IED from the Object Types view to the bay
level.
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2. On the Configuration mode selection page, select Offline configuration and
click Next.

Setting up an IED in the offline mode is similar to the online mode; however,
with the offline mode it is not necessary to type the correct IP address in the IP
address box.

Figure 28: Selecting the configuration mode
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3. On the Composition code selection page, select the correct composition codes
and click Next.

Ensure that the composition code is correct. PCM600 verifies that
the composition code matches the relay. If the composition code
digits related to the configuration, I/O or version do not match the
relay, PCM600 does not allow writing the configuration to the relay. If
other digits in the composition code do not match, PCM600 informs
about the mismatch with a dialog box.

Figure 29: Selecting the composition code

4. On the Configuration Selection Page, select the configuration type and click
Next.

• Select Empty configuration to create an empty configuration.
• Select Import configuration from file (PCMI/PCMT) to import an example

configuration.

Click Browse to select the .pcmi/.pcmt file that has the example
configuration.

• Select Default configuration (available only for IEC 61850 Edition 2) to
generate a default configuration.

If a default configuration is selected, the next page is skipped as
default configuration is only supported for the IEC 61850 Edition
2 IEDs. To configure an IEC 61850 Edition 1 IED, select empty or
example configuration and make the proper selection on the next
page.

5. On the Version Selection page, select the IEC 61850 version and click Next to
generate the functions.

1MRS759117 D Setting up a project

REX640
Engineering Manual

55



6. The Summary page shows the summary of the IED type, IP address and
the selected composition code. Click Finish to confirm the configuration and
conduct the insertion.

4.3.3 Inserting an IED from the template directory

IED templates can be used to replicate IEDs with the same order code in
PCM600 projects. The template includes an IED application configuration, graphical
display configuration (single-line diagram), communication protocol mappings and
parameters. An IED in the plant structure can be exported as a template (.pcmt file).
The template library can be built from all the exported IED templates.

It is also possible to insert an IED from the template library to create a new IED in
the plant structure. After a template IED has been imported, IP address and Caption
in IED's Object Properties and Technical Key of the physical IED have to be changed.

1. In the Plant Structure view, select the bay or IED group, right-click, point to New
and select Create from template.

2. In the Create New Object from Template dialog box, select the IED under
Available Object Types.

Figure 30: PCM600: Selecting an IED from the template library

3. Click the icon on the rightmost column in the list of available templates.
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4. In the Template Properties dialog box, verify the template information and click
Close.

Figure 31: PCM600: Template information

5. In the Create New Object from Template dialog box, delete, import or create a
template by clicking the corresponding button.

• To delete the selected template, click Delete Template.
• To import a template from the selection window, click Import Template.
• To insert the selected IED to the bay, click Create.

It is possible to insert more than one IED from the Create New
Object from Template dialog box. The dialog box remains open until
Close is clicked.

6. Click Close when finished.
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4.3.4 Inserting an IED by importing a .pcmi file
1. In the Plant Structure view, right-click the bay and select Import.

A .pcmi file can be imported only when the bay is selected in the
plant structure.

Figure 32: Importing IED configuration

2. In the Import dialog box, select the .pcmi file to be imported and click Open.
After importing, the IED object is created in the plant structure.

After the .pcmi file has been imported, the IP address, the name and the technical
key of the physical IED have to be changed.
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4.4 Setting IED's IP address in a project

The IP address and subnet mask of the IED object in PCM600 must match the HMI
and LAN ports of the protection relay (physical IED) to which the PC is connected.
The IP address of the protection relay can only be set via the LHMI or Parameter
Setting in PCM600. The PC and protection relay need to be on the same subnet.

There are two ways to set the IP address of an IED object in PCM600: on the first
page of the wizard when including a new IED into a project or in the IP address box
of the IED's Object Properties pane.

Choosing between the two ways depends on when the IP address is set. Typing the
IP address via the IED's Object Properties pane is possible at any time while entering
it via the configuration wizard can only be done when inserting the IED in online or
offline mode.

Figure 33: Alternative 1: Setting the IP address on the first wizard page

1. In the Plant Structure view, select the IED whose IP address must be entered.
2. On the View menu, select Object Properties.
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3. In the Object Properties pane, type the IP address in the IP Address box.

Figure 34: Alternative 2: Setting the IP address in the IED's Object Properties
pane

4.5 Using the Web HMI
Connection to WHMI can be established using different communication card
ports or the LHMI service port. WHMI is disabled by default and can be enabled
with a setting parameter. As only secure communication is supported for the
WHMI, it must be accessed from a Web browser using the HTTPS protocol. Three
simultaneous LHMI and WHMI sessions are supported.

1. To enable the WHMI, select Configuration > HMI > Web HMI mode and set the
parameter to "On".

2. Reboot the relay for the change to take effect.
3. Log in with the proper user rights to use the WHMI.

If the WHMI is accessed through the LHMI service port, use the corresponding
IP address of the relay communication port. The IP address can be obtained via
the Engineer pages. Tap the relay's name on the LHMI menu bar to open the
Relay address dialog box.

To establish a remote WHMI connection to the protection
relay, contact the network administrator to check the
company rules for IP and remote connections.

HTTPS is enabled for all ports by default. To disable
the HTTPS for station ports, select Communication >
Protocols > Network1 > HTTPS or Communication >
Protocols > Network2 > HTTPS and set the parameter to
"Off". HTTPS is always enabled for the X0/HMI port.

The WHMI write access can be limited with the parameter
HTTPS write access in Configuration > Authorization >
Network1 or Configuration > Authorization > Network2.

Disable the Web browser proxy settings or make an
exception to the proxy rules to allow the protection relay's
WHMI connection, for example, by including the relay's
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IP address in Internet Options > Connections > LAN
Settings > Advanced > Exceptions.

4.6 Relay user management
The user account management and role-based access control in the protection
relay have been handled as specified in IEC 62351-8. The relay supports both local
user account and central account management. For information on how to set up
user account management, see user management in the cyber security deployment
guideline.

1MRS759117 D Setting up a project

REX640
Engineering Manual

61



4.7 PCM600 project's IEC 61850 version identification
The IEC 61850 version of a PCM600 project can be identified from the Object
Properties pane of the project.

Figure 35: Project's IEC 61850 version

To change IEC 61850 version Edition 1 of an IED to Edition 2, the configuration has
to be written to the IED from a PCM600 project that has IEC 61850 version Edition 2.
A dialog box notifies of the version difference.

Figure 36: IEC 61850 version change
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5 Protection and control engineering

5.1 Application Configuration
Application Configuration is used to modify an application configuration for a
protection relay and is based on IEC 61131-3 Function Block Diagrams.

The function blocks are dedicated to different functions such as control related,
protection related, monitoring or communication functions. For more information
on the function blocks, see the technical manual.

Most function blocks are mapped as logical nodes according to the IEC 61850
standard. See the IEC 61850 parameter list for more information.

If a function block is removed with Application Configuration, the function-
related data disappears from the menus as well as from the IEC 61850 data
model, with the exception of some basic function blocks, which are mandatory
and thus cannot be removed from the relay configuration by removing them
from Application Configuration. The mandatory function blocks are: ETHLDEV1,
ETHLDEV2, FTPLPRT1, GNRLLTIM1, GNRLLTMS1, GSAL1, GSELPRT1, HMILCCH1,
HMILDEV1, HTTPLPRT1, LDEV1, LEDPTRC1, LINF1, LLN0, LPHD1, MMSLPRT1,
RCHLCCH1, SA2LINF1, SBBIGGIO1, SBBOGGIO1, SBLINF1, SCHLCCH1, SCHLCCH2,
SCHLCCH3, SCHLCCH6, SFAIGGIO1, SFLINF1, SGBOGGIO1 and SGLINF1.

Some of the protocol-related LPRT function blocks contain outputs which can be
used to monitor protocol status. For example, the CHLIV output can be used to
monitor if protocol-related messages are received from the client. However, all
function blocks do not have outputs as they may just be visual objects to indicate
protocol support when the sheet is printed out. This applies also to the PKIGSAL
and LDEV function blocks. Security related function block GSAL has the DOS_ALARM
and DOS_WARNING outputs for indicating denial of service warning and alarm event.

Other function blocks are not mapped as logical nodes; for example, logical gates.

The basic features of Application Configuration include the ability to organize
a configuration into several MainApplications as well as providing different
application programming features.

• Organizing an application configuration

- Organizing an application configuration into a number of logical parts
(MainApplication)

- Organizing a MainApplication over a number of pages
• Features for programming an application configuration
• Inserting function blocks, making connections and creating variables
• Including the hardware I/O channels directly in the application configuration
• Calculating the execution order automatically by clicking Calculate execution

order on the toolbar
• Documenting the application configuration, for example, by making printouts
• Saving application configurations as templates in an application library to reuse

them in other protection relays. Function blocks and the related logic can be
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fully or partially reused depending on the functionality available in the other
protection relay.

• Validating the application configuration during the configuration process on
demand and while writing the application configuration to the protection relay

For instructions on how to perform the different tasks in PCM600, see
PCM600 online help.

5.1.1 Function blocks
Function blocks are the main elements of an application configuration. They are
designed for a various number of functions and organized into groups according
to type. The different function block types are shown in the Object Types view.
Function block data can be modified with Application Configuration in PCM600.

• User-defined names can be given for function blocks and signals.

Signals that have a user-defined name created with Application
Configuration are visible in Parameter Setting in PCM600 only if the
relay configuration is written to the protection relay and read back
to PCM600. Otherwise, only the default signal name is shown in
Parameter Setting.

Restart the relay to ensure that all user-defined names for the
disturbance recorder's Channel id texts are updated on the LHMI,
WHMI and Parameter Setting menus.

If possible, set the user-defined name to a signal before connecting
the signal to other function blocks.

• IEC 61850, ANSI or IEC 60617 symbol standard can be set.
• IEC or ANSI naming style can be set.
• Function blocks can be locked.
• Visibility for execution order, cycle time and instance number can be set.
• Signals can be managed.
• Boolean inputs and outputs can be inverted.

1 2 3 4 5 76

8 9 10 11 12 13 14

1 Connections
2 User-defined function block name
3 Function block, selected (red)
4 Function block name
5 Function block, locked

6 Hardware, binary output channel
7 Hardware, programmable LED
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8 Hardware, binary input channel
9 Hardware, analog input channel
10 User-defined signal name
11 User-defined input variable

12 Execution order
13 Cycle time
14 Instance number

Figure 37: Application Configuration: function block overview

5.1.2 Signals and signal management
The function block has a set of input and output signals. The placement of function
block signals is from left to right. Input signals are placed on the left and output
signals on the right.

Function blocks can contain more signals than needed in an application part.
Unused signals can be hidden to get a clear picture.

Signals are located up and down on both sides of the middle position. When there
is space left, some signals may be moved up or down for better visibility and
connection routing.

Boolean input and output signals may need to be inverted to fulfil the logic. The
Application Configuration tool supports the adding of inversion logic to a binary
signal.

All input signals have a default value that is used when the signals are not connected
in the configuration.

The input signal on glue logic function blocks can be inverted only if a
glue logic function block with lower execution order in the same cycle
time is available. Similarly, the output signal can only be inverted if a glue
logic function block with higher execution order in the same cycle time is
available. Up to two input signals and two output signals can be inverted
for glue logic blocks in the same cycle time.

5.1.3 Function block execution parameters
Three function block execution parameters influence the runtime execution of the
function block within the application configuration.

• Execution order
• Cycle time
• Instance number

When a new function block is inserted, these parameters are shown in the Function
Block Instance dialog box in Application Configuration. The three parameters are
selectable or not selectable depending on the function block type. The cycle time
is predefined to one value. The instance number is a counter for the total possible
number of function blocks of that type used within the application configuration.

Execution Order and Instance Number are a combination that is predefined within a
product. It is possible to select a pair out of the list.

1MRS759117 D Protection and control engineering

REX640
Engineering Manual

65



Figure 38: Application Configuration tool: an example of function block organization
parameters

Cycle Time is automatically set and it cannot be modified.

To automatically calculate the execution order, click Calculate Execution
Order on the tool bar.

5.1.4 Execution order and feedback loops
It is possible to draw a multi-layer configuration logic that contains feedback loops
with the Application Configuration tool. The execution order of logic functions
is calculated automatically in the Application Configuration tool, but it can also
be set manually. If the automatically calculated value causes the function to be
executed one task cycle time after the other logic functions in the same loop, the
execution order number can be set manually to prevent delays, for example, in
output activation.

To perceive accurate time stamps from binary input signals to function
blocks, direct logic connection should be used in the Application
Configuration tool. Due to the internal execution order, time stamps may
not be accurate if an additional logic is used to connect priority signals
to function blocks.

Figure 39 shows a simple situation where the execution order causes one cycle
time delay if the NOT gate is executed in the order determined by the automatic
calculation.

Protection and control engineering 1MRS759117 D

66 REX640
Engineering Manual



Figure 39: Feedback loop situation with automatically calculated execution orders

By setting a smaller execution number than in the AND port to where the NOT port
is connected, it is possible to fix the execution order of all functions in a loop so that
they are handled in the same task.

Figure 40: Feedback loop situation with manually fixed execution order for NOT port

The execution number can be changed by right-clicking the function and selecting
Change CycleTime ExecOrder.

After manually defining the execution number, the function is excluded from the
automatic execution order calculation. The function can be included back to the
automatic calculation by right-clicking the function and selecting Include FB in
calculation.

5.1.5 Connections and variables
A connection is the link or "wire" between function block outputs and inputs.

Connections can be made in two ways.

• Dragging a line between two signals
• Linking two signals by using variables

It is possible to search and replace variable names in Application
Configuration tool.

Connect the variables to a destination, for example to a function block
or a hardware output channel. The connectivity package automatically
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removes the orphan variables which are not connected to any
destination.

Connect at least one analog input signal from AIM or SMVRCV.

Connection validation

A connection is only useful or even possible between two signals of the same base
attribute type.

Figure 41: Application Configuration tool: an error message of a signal mismatch for
a connection

5.1.6 Hardware channels
Hardware channels can be connected only to a function block input or output. A
hardware connection can be established with Application Configuration or Signal
Matrix.

When a hardware channel is connected, a graphical symbol appears in Application
Configuration. The connection is also indicated in Signal Matrix with a cross mark.
All hardware channels are always visible in Signal Matrix.
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Slot B (BIO).X1-1;4_BI1

Slot B (BIO).X1-2;4_BI2

Slot B (BIO).X1-3;4_BI3

Slot B (BIO).X1-5;8_BI4

Slot B (BIO).X1-6;8_BI5

Slot B (BIO).X1-7;8_BI6

T_R_TO_I8
REAL_IN INT8_OUT

SlotC-RTD1
AI_VAL

HIGH_ALARM
HIGH_WARN
LOW_WARN

LOW_ALARM
SENSOR_FLT

TPOSYLTC1
BI0
BI1
BI2
BI3
BI4
BI5

END_POS_R
END_POS_L

SIGN_BIT

TAP_POS

TAP_POS

Figure 42: Application Configuration: HW signal channels

There are three types of supported hardware channels.

• Binary input channels
• Binary output channels
• Analog input channels

Hardware binary input channels may have multiple connections. A hardware binary
output channel is taken from the list of available channels when a new channel is
requested. This prevents using the same hardware binary output channel twice.

5.1.6.1 Hardware channel configuration
Instead of pre-configured I/O channel connections to pre-processing function
blocks, user-customized configurations can be used. There are some rules which
must be followed to create a working configuration. Application Configuration
automatically checks if configuration is valid and results are shown in the output
pane. See the technical manual for the minimum I/O requirement per application
function block.

Example 1
ILTCTR1

O:11|T:2,5|I:1

IL1
IL2
IL3

ALARM
WARNING

I3P
IRES_CLC

IRES_CLC_DR
IL1_DR
IL2_DR
IL3_DR

NPS_DR
PPS_DR

ILTCTR1[1]_I3P

Slot F (SIM).X1-Sensor_I

Slot F (SIM).X2-Sensor_I

Slot F (SIM).X3-Sensor_I

Figure 43: Missing required input connection for output

ILTCTR1

O:11|T:2,5|I:1

IL1
IL2
IL3

ALARM
WARNING

I3P
IRES_CLC

IRES_CLC_DR
IL1_DR
IL2_DR
IL3_DR

NPS_DR
PPS_DR

ILTCTR1[1]_I3P

Slot F (SIM).X1-Sensor_I

Slot F (SIM).X2-Sensor_I

Slot F (SIM).X3-Sensor_I

Figure 44: All required input connections configured for output
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In Figure 43, the output connection requires more input channels to be connected.
Figure 44 has correction for Figure 43 where all required inputs are configured and
the input order is according to installation.

When an output is not connected to any function block, Application
Configuration considers the configuration valid. Check validation
warnings from the output pane for possible missing connections. Once
the output is connected, the complete configuration is validated again.

Example 2

UTVTR1

O:2|T:2,5|I:1

UL1
UL2
UL3
MINCB_OPEN
URES

ALARM
WARNING

URES_ALARM
URES_WARNING

U3P
URES_CLC

URES_MEAS
URES_CLC_DR

URES_MEAS_DR
U1_DR
U2_DR
U3_DR

NPS_DR
PPS_DR

FREQ_DR

UTVTR1[1]_URES_MEAS

Slot F (SIM).X4-1;2_VT

Figure 45: Output connection requiring only one input

UTVTR1

O:2|T:2,5|I:1

UL1
UL2
UL3
MINCB_OPEN
URES

ALARM
WARNING

URES_ALARM
URES_WARNING

U3P
URES_CLC

URES_MEAS
URES_CLC_DR

URES_MEAS_DR
U1_DR
U2_DR
U3_DR

NPS_DR
PPS_DR

FREQ_DR

UTVTR1[1]_URES_MEAS

Slot F (SIM).X4-1;2_VT

Slot F (SIM).X1-Sensor_U

UTVTR1[1]_U3P

Figure 46: Two output connections requiring two inputs

UTVTR ULx inputs can be used as one-, two- or three-phase connection. The ACT
blocks connected to U3P may further demand two- or three-phase connection. URES
input must be connected if URES_MEAS output is used. Figure 45 illustrates the
use case of only residual voltage being used in UTVTR1. Figure 46 illustrates a case
where one residual voltage and one phase voltage are sufficient.
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Example 3
UTVTR1

O:2|T:2,5|I:1

UL1
UL2
UL3
MINCB_OPEN
URES

ALARM
WARNING

URES_ALARM
URES_WARNING

U3P
URES_CLC

URES_MEAS
URES_CLC_DR

URES_MEAS_DR
U1_DR
U2_DR
U3_DR

NPS_DR
PPS_DR

FREQ_DR

UTVTR1[1]_URES_MEAS

UTVTR1[1]_U3P

SMVRCV1

O:2|T:2,5|I:1

UL1
UL2
UL3
Uo
IL1
IL2
IL3
Io

Figure 47: Remote samples as input connections

UTVTR1

O:12|T:2,5|I:1

UL1
UL2
UL3
MINCB_OPEN
URES

ALARM
WARNING

URES_ALARM
URES_WARNING

U3P
URES_CLC

URES_MEAS
URES_CLC_DR

URES_MEAS_DR
U1_DR
U2_DR
U3_DR

NPS_DR
PPS_DR

FREQ_DR

SMVSENDER

O:14|T:2,5|I:0

I3P
IRES
U3P
URES

ILTCTR1

O:11|T:2,5|I:1

IL1
IL2
IL3

ALARM
WARNING

I3P
IRES_CLC

IRES_CLC_DR
IL1_DR
IL2_DR
IL3_DR

NPS_DR
PPS_DR

Protection[0]_GRPOFF

Slot F (SIM).X1-Sensor_I

Slot F (SIM).X2-Sensor_I

Slot F (SIM).X3-Sensor_I

Slot F (SIM).X1-Sensor_U

Slot F (SIM).X2-Sensor_U

Slot F (SIM).X3-Sensor_U

Figure 48: Local inputs sent out as remote samples

Instead of local hardware inputs in Figure 47, remote samples can be used by local
function blocks. Remote samples sender can also be configured as described in
Figure 48, where GRP_OFF is used to indicate that channel is not available locally.
See the technical manual for details about GRP_OFF.

TVTR and TCTR function blocks accept analog channels connected only
either from local or remote, that is, local and remote channels cannot be
mixed within a TVTR/TCTR function block.

It is not possible to forward the received remote analog channels.

An analog input can only be connected to one function block. Triplets
(for example, U3P and I3P) should be used instead in the application to
connect analog inputs to other function blocks.
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Example 4

LED10

O:2|T:2,5|I:10

OK
ALARM
RESET

Slot B (BIO).X1-1;4_BI1 Input 1 ALARM

Figure 49: Hardware binary input channel shared by function blocks

GOOSERCV_BIN

O:15|T:2,5|I:0

IN OUT
VALID

OR

O:19|T:2,5|I:0

B1
B2

O

LED14

O:17|T:2,5|I:14

OK
ALARM
RESET

INTERLOCK

Figure 50: GOOSE input shared by function blocks

SlotC-RTD2

O:2|T:2,5|I:5

AI_VAL
HIGH_ALARM
HIGH_WARN
LOW_WARN

LOW_ALARM
SENSOR_FLT

SlotC-mA1

O:2|T:2,5|I:2

AO_VAL AI_VAL
HIGH_ALARM
HIGH_WARN
LOW_WARN

LOW_ALARM

SlotC-mA2

O:2|T:2,5|I:3

AO_VAL AI_VAL
HIGH_ALARM
HIGH_WARN
LOW_WARN

LOW_ALARM

Figure 51: RTD input shared by function blocks

GOOSE, RTD and binary inputs can be shared by multiple function blocks.

5.1.7 Online monitoring
Online monitoring enables the continuous monitoring of the signal or channel
values in the configuration. In the Online monitoring mode, the configuration
cannot be edited in the Application Configuration tool.

Online monitoring can be started by clicking the Work online button in the
toolbar. If the application configurations in the IED and PCM600 are the same, the
online monitoring starts. The online monitoring ends and the tool returns to the
configuration mode if the Work Offline button is clicked.

Online monitoring cannot be started if the application configurations in
IED and PCM600 are different.

In some cases when the function block input is directly mapped to the
function block output, the input is internally forced to the correct value
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depending on the function block's settings. This function block design is
present in control blocks, setting group handling and tap changer.

5.1.8 Validation
Validation checks the application configuration for errors based on the rules that
govern the application creation at three different times.

• During the logic creation, while making a connection or placing a function block
• On demand by starting the validation
• When writing the application configuration to the protection relay

5.1.8.1 Validation when creating application configuration
Certain conditions require the validation to be made when creating the application
configuration.

• A connection between two input or two output signals is not possible
• A connection between two different data types is not possible: for example, from

a binary output to an analog input

5.1.8.2 Validation on demand
The validity of an application configuration can be checked by clicking Validate
Configuration in the toolbar. The Application Configuration tool checks the
application configuration for formal correctness. The found problems are divided
into warnings and errors.

• Warnings, marked with a yellow warning icon

- Example: a variable connected to an output signal that is not connected
- Example: if an output from a higher execution order function is connected to

the inputs of a lower execution order function
• Errors, marked with a red circle with a cross

- Example: unconnected hardware output

Warnings do not prevent writing to the protection relay. However, errors must be
corrected before writing the application configuration to the protection relay. The
application configuration can be saved and the Application Configuration tool can
be closed with open errors, but the application configuration cannot be written to
the protection relay.

These problems are listed in the Output view under the Application Configuration
tab. Double-clicking the error or warning row navigates to the MainApplication >
Page > Area, where the problem was identified.
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Figure 52: Application Configuration tool: validation on demand

5.1.8.3 Validation when writing to protection relay
When writing the application configuration to the protection relay, an automatic
validation is performed. Errors abort the writing.

5.1.9 Configuration load calculation
The connectivity package calculates an estimated application configuration load
every time it is saved in Application Configuration or written to the IED. This
functionality prevents too complex configurations from being used and possibly
risking IED protection functionality.

Calculation results are divided into two different sections: OK and Error. At
100 percent, PCM600 can give either an OK or an error message because the
connectivity package rounds the actual limit to the closest percentage. If the
calculation result is above 100 percent, PCM600 always gives an error message and
prevents writing the configuration to the IED as the configuration is too large for
the IED to handle. The configuration is written to the IED if the result is below the
error range.

The calculation result is visible only in PCM600 output window on the
Logging tab.
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Figure 53: Configuration load result: an example of different messages shown in
PCM600

5.2 Parameter Setting
Configuration and setting parameters can be changed with LHMI, WHMI or with the
Parameter Setting tool in PCM600.

Some parameters are only visible in the Parameter Setting tool and some
only on the LHMI.

The Write to IED command from PCM600 to the protection relay
overwrites any parameter changes made with the HMI.

All parameters displayed in the parameter list can be sorted into two groups.

• Configuration parameters
• Setting parameters

5.2.1 Configuration parameter
The configuration parameter specifies the operation mode of an application
function or of the protection relay. These are basic configurations that are normally
configured only once and then not modified again. The protection relay configures
itself during start-up according to the given configuration parameter values.

5.2.2 Setting parameter
Setting parameter (short form: “setting”) is a parameter that can be changed in the
protection relay at runtime.

5.2.3 Setting group
Nearly all settings used by the protection relay for protection application functions
are organized into a group of settings. Up to six setting groups can be configured
with different values.

The protection relay supports the selection of a setting group at runtime.

5.2.4 Parameter import and export
The parameter export and import function can be used, for example, when the
protection relay's parameters are set using the WHMI instead of PCM600. The relay
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settings engineered with PCM600 can be exported to XRIO files and imported to the
WHMI, which can be used to write the settings to the protection relays. The WHMI
can also be used to read the relay setting parameters and to export those to files,
which can be used by PCM600.

The setting export and import are sensitive to the protection relay's
content. Settings are exported and imported for one protection relay
at a time. The export files of a protection relay can be exchanged
between PCM600, WHMI and the actual physical IED. To avoid errors
and to efficiently manage the setting export and import, for example,
in a substation with several protection relays, ensure that the names of
the export files identify the protection relay to which the file should be
imported.

The parameter import and export functionality is available via the File menu when
the Parameter Setting tool is open.

Figure 54: Parameter import and export

5.2.5 Parameter organization
The organization of parameters into a tree structure can be seen in the Plant
Structure by expanding the setting tree.

5.3 Configure Autosynchronization
Manual configuration of the autosynchronization scheme in PCM600 is time-
consuming and complex in case the system contains both generator circuit breakers
and non-generator circuit breakers, that is, non-source circuit breakers. Configure
Autosynchronization in PCM600 can be used to simplify the configuration process.
The autosynchronization scheme for a given project can be configured via user-
understandable terminologies regarding the system to understand the network
topology.

The relay supports synchronizing of GCBs and NSCBs, such as grid connection or
bus coupler circuit breakers, by providing dedicated function blocks to perform the
synchronization process.

• ASGCSYN is used for GCB synchronization.
• ASNSCSYN is used for NSCB synchronization.
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• ASCGAPC is a coordination function that handles the control request and allows
communication among the relays connected to the autosynchronization system.

Configure Autosynchronization generates a configuration with IEC61850-8-1
GOOSE engineering, function block parameters in Parameter Setting and relevant
connections in Application Configuration for ASGCSYN, ASNSCSYN and ASCGAPC.
Further, the tool displays the configured network topology as an SLD preview.

Starting Configure Autosynchronization

Configuring topology for non-generator circuit breakers

Configuring topology for generator circuit breakers

Verifying configuration with SLD preview

Initiating generation of autosynchronization configuration

Figure 55: Simple engineering flow for Configure Autosynchronization

After using Configure Autosynchronization, manually handle the
connections for voltage measurements, inputs and outputs to ASGCSYN,
ASNSCSYN and ASCGAPC in Application Configuration. For functional
details, see the technical and application manuals.

5.3.1 Example case
Figure 56 presents a 11 kV network with a generator, grid connection, bus
sectionalizers, local power generation and two feeder loads to illustrate a more
realistic application. The target is to create a complete autosynchronization system
were each of the breakers, except for CB1 and CB2, are capable of performing
synchronized closing. The system is continuously aware of the relevant primary
objects’ switching status as well as the availability of the generator. Depending
on which circuit breaker is selected for synchronization, the system checks the
conditions and proceeds only if the selected circuit breaker is viable. As the feeder
relays do not have any dependency on the autosynchronization system, they are not
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explained further in this example. This example case is used in the selections made
in the following chapters.

Figure 56: Example case for the autosynchronization scheme

Figure 57 presents the terminology used in a typical topology for different busbar
arrangements containing an NSCB. It only depicts the logical connections and does
not represent any primary network.

Figure 57: Terminology used in a typical topology containing a non-generator circuit
breaker

Figure 58 presents the terminology used in a typical topology for different busbar
arrangements containing a GCB. It only depicts the logical connections and does
not represent any primary network.
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Figure 58: Terminology used in a topology containing a generator circuit breaker

5.3.2 Configuring autosynchronization scheme
If Autosynchronization Configuration has already been used to successfully
generate an autosynchronization configuration, relaunching the tool loads the
previously made configuration to the respective pages. Any existing connections
in Application Configuration or settings in Parameter Setting made to ASGCSYN,
ASNSCSYN or ASCGAPC must be reconfigured as they are removed from the
configurations of the respective relays after relaunching Autosynchronization
Configuration.

1. In the Plant Structure, right-click Substation or IED Group and select Configure
Autosynchronization.

Configure Autosynchronization can be opened only if there are at
least two relays in the PCM600 project: one with the Generator
autosynchronizer application package and the other with the
Network autosynchronizer application package. No other tools
should be open in PCM600.

2. On Welcome Page , click Next to configure first the topology for NSCBs and
then for GCBs.

3. On the Non-generator Configuration page, configure the topology by adding,
removing or clearing NSCBs.

The page displays the relays from the PCM600 project setup that support the
Network autosynchronizer application package. It is possible to synchronize up
to 17 NSCBs in the configuration.

- IED Name: Shows a list of relays with non-generator capabilities that can be
selected and added to the configuration

- IP Address: Shows the IP address of the selected non-generator (read only)
- Non-generator CB ID: Shows an autogenerated non-generator circuit

breaker ID to identify the breaker in the SLD preview controlled by the relay
(read only)

- Breakers: Used to specify the number of breakers a relay can control
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- Bus A1: Used to specify the Bus A1 value for a non-generator in a single bus
system

- Bus A2: Used to specify the Bus A2 value for a non-generator in a single bus
system

- Bus B1: Used to specify the Bus B1 value for a non-generator in a double bus
system

- Bus B2: Used to specify the Bus B2 value for a non-generator in a double bus
system

Bus A1 and Bus A2 are mandatory to configure for non-generators.
Use unique values in Bus A1, Bus A2, Bus B1 and Bus B2 for a given
non-generator.

Figure 59: Configuring the topology for non-generator circuit breakers
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4. Correct any invalid selections highlighted in yellow to be able to proceed and
click Next.

Figure 60: Correcting invalid non-generator circuit breaker selections

5. On the Generator Configuration page, configure the topology by adding,
removing or clearing GCBs.

The page displays the relays from the PCM600 project setup that support the
Generator autosynchronizer application package. It is possible to synchronize
up to eight GCBs to the configuration.

- IED Name: Shows a list of relays with generator capabilities that can be
selected and added to the configuration

- IP Address: Shows the IP address of the selected generator (read only)
- Generator Name: Used to specify a user-defined name for the generator
- Bus A: Used to specify the Bus A value for a generator in a single bus system
- Bus B: Used to specify the Bus B value for a generator in a double bus system

Bus A and Generator Name are mandatory to configure for
generators. Use unique values in Bus A and Bus B for a given
generator.

The value in Generator Name is later shown in the SLD preview and
the REX640 LHMI dialog where the synchronization for NSCBs is
initiated. The generator name can be modified in this field only.
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Figure 61: Configuring the topology for generator circuit breakers

6. Correct any invalid selections highlighted in yellow to be able to proceed and
click Next.

Figure 62: Correcting invalid generator circuit breaker selections
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7. On Summary Page, verify the configuration with the SLD preview and click Next.

The page shows an SLD based on the network topology entered in the previous
pages and a report regarding the configuration changes made along with their
impact on the relays. Figure 63 shows a part of the page which displays the SLD
generated based on the case presented in the Chapter 5.3.1 Example case.

Figure 63: SLD preview for the example case

If the SLD preview is compressed and not properly visible, double-
click the SLD to open the preview in a separate dialog with zoom
buttons and scroll bars.

The autosynchronization configuration for ASGCSYN, ASNSCSYN
and ASCGAPC is modified in Application Configuration, Parameter
Setting and GOOSE engineering.
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8. Verify the configuration made against the SLD preview and click Next to initiate
the generation of autosynchronization configuration for the respective relays.

In case Autosynchronization Configuration has already been used
to complete the configuration, the impact of configuration changes
for each relay is shown on Summary Page. Review the configuration
changes by comparing the SLDs of the current and previous
configurations before initiating the configuration generation.

Figure 64: Reviewing configuration changes

Figure 65: Generating configuration

9. On Finish Page, click Finish to close the tool.

The page displays the configuration created as an SLD and the status of the
autosynchronization configuration generation.

Figure 66: Finish Page

5.3.3 Finalizing of generated autosynchronization configuration
Configure Autosynchronization generates a partial configuration in Application
Configuration and Parameter Setting and a complete GOOSE engineering for the
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function blocks ASGCSYN, ASNSCSYN and ASCGAPC. The remaining connections for
voltage measurements and other inputs and outputs need to be handled manually
in PCM600.

For functional details, see the technical and application manuals.

With reference to the example given in the Chapter 5.3.1 Example case chapter, the
following figures show the partial configuration generated by the tool in PCM600.

Figure 67 shows the Application Configuration view of the relay controlling NSCB1.
Similar connections are also generated for the other relays. The connections for the
function blocks shown in the figure should be completed next.

Figure 67: Application Configuration view of relay controlling NSCB1

Figure 68 shows part of the Parameter Setting view of ASCGAPC of the relay
controlling NSCB1. Similar settings are also made for ASCGAPC in other relays.
The other settings for ASGCSYN, ASNSCSYN and ASCGAPC should be checked and
modified, if needed.
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Figure 68: Partial Parameter Setting view of ASCGAPC in the relay controlling NSCB1

Figure 69 shows the GOOSE data sets generated by the tool containing all the
entries required to be exchanged among the relays for the autosynchronization
process. No further user actions are required regarding the GOOSE engineering
for the autosynchronization process. However, GOOSE data exchange for any other
logic or scheme may be handled manually.

Figure 69: GOOSE data sets in IEC 61850 Configuration
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5.4 Signal Matrix
Signal Matrix is used to make cross-references between the physical I/O signals,
function blocks and SMV and for the GOOSE signal input engineering.

Application Configuration is used for adding or removing function
blocks, for example, GOOSE receiving function blocks.

BIO

BIO

RTD/ mA Inputs

FBs
Binary
Inputs

Binary
Outputs

Analog
Inputs/
Outputs

FBs

FBs

IEC 61850 GOOSERCV
(input side)GOOSE

FBs
GOOSERCV/ SMVRCV

(input side)

IEC 61850 9-2 LE SMVRCV
(input side)SMV

mA Outputs

Figure 70: Signal Matrix: operation principles

A binary input channel can be connected to one or more function block inputs.
If a binary input channel is connected to several different function blocks in the
Application Configuration tool, the connection appears as glue logic in Signal
Matrix.

A binary output channel can only be activated from one function block output. If it is
activated from more than one function block output, the glue logic has to be used.
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Glue logic means inserting a logical gate (OR and AND blocks) between the binary
input and the function blocks or between the function blocks and the binary output
channel. This can be engineered with the Signal Matrix.

Connections made with Signal Matrix are automatically shown in
Application Configuration.

Figure 71: Signal Matrix: a connection between binary input channels to binary input
signals

Each SMVRCV block used in Application Configuration needs to be connected to
the desired SMV stream in Signal Matrix. Connections need to be one-to-one and
unconnected SMVRCV blocks are not allowed.

Signal Matrix has a separate sheet for each possible combination.

• Binary inputs
• Binary outputs
• Analog inputs
• GOOSE
• SMV

5.5 Load Profile tool
Load Profile tool is used for reading load profile records of COMTRADE format
from a protection relay, clearing old records and viewing records via an external
COMTRADE viewer. The default viewer included with PCM600 is Wavewin, but a
third-party viewer can be used.
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5.5.1 Opening and closing Load Profile tool
• To open the Load Profile tool, right-click an IED in the PCM600 project tree and

select Load Profile Tool.
• To close the Load Profile tool, click Close in the tool. The Load Profile tool runs

in the same process as PCM600 but in a separate window. Multiple instances of
the tool can be run at the same time. Any open tool instances are closed without
confirmation when PCM600 is closed.

Figure 72: Load Profile tool

By default, the Load Profile tool uses the \PCMDataBases\LPR directory as a saving
target directory.
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5.5.2 Load Profile tool user interface

Figure 73: Load Profile tool interface

Table 3: Available actions on the user interface

Action Description

Local Path Default local path (C:\PCMDataBases\LPR) is the location from which
the records are shown on the Load Profile tool. It is also the default
path for saving records. The location where the records are saved can be
changed in the Local Path field. The grid of the Load Profile tool shows
only the records in the default local path including any unsaved records
in C:\Temp\Load\Profile Tool. Therefore records can be saved at
a user-specified location on the local machine but those records are not
visible in the grid of the Load Profile tool.

Load Clicking Load downloads all available records from C:\LDP\COMTRADE
directory in the protection relay to a temporary folder C:\Temp\Load-
ProfileTool on the local machine. In this temporary folder, the target
file name is constant, and loading again overwrites the file. An unsaved
record is deleted when the tool is closed.

Save Clicking Save moves the records to the default or specified local path,
Load transfers the records to a temporary folder. Each load profile record
comprises two files with file extensions .dat and .cfg.

Clicking Save adds a time stamp to the file names and moves the two files
pertaining to the record to the default or specified folder. Saving another
record creates a new record in addition to the old ones.

Clear Clicking Clear clears the record from either the Load Profile tool or protec-
tion relay or both. Before deleting the records, a confirmation dialog box is
shown.

Table continues on the next page
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Action Description

Open Clicking Open opens any selected record to be viewed in Wavewin, provided
that this external software is installed. Additionally, any record row can be
double-clicked to view that record.

Sort Record rows can be sorted by any column by clicking the column header.

Close Clicking Close closes the tool instance. All open tool instances are closed
when PCM600 is closed.

File All the actions are also available on the File menu.

5.5.3 Information fields
The IP box shows the IP address of the selected IED and the Local Path box shows
the selected location for reading or viewing records.

The record grid shows the name, creation time, modification time and size of each
record. The times and dates shown in the grid are the times when the files have
been read rather than the original date stamps in the device.

Figure 74: Information fields

5.6 Fault Record tool
The Fault Record tool is used for reading the fault records from the protection relay.
The tool makes analyzing the fault records easier by showing them separately in
their own user control components. It also includes save, copy and clear functions
where all the fault records are saved or copied in text format for later viewing or
cleared from the protection relay or the tool.

The fault record is saved to a local PC with the default name
FaultRecords.txt. Rename the file before saving it to avoid overriding
the old record.

5.6.1 Opening and closing Fault Record tool
• To open the Fault Record tool, right-click an IED node in the PCM600 project tree

and select Fault Record Tool.
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• To close the Fault Record tool, click the Close button in the tool.

The Fault Record tool runs in the same process as PCM600 but in a separate
window. Multiple instances of the tool can be run at the same time. Any open tool
instances are closed without confirmation when PCM600 is closed.

The main functionality is divided into three parts: reading the fault record
parameters from the protection relay, displaying their names, values and units on
the user interface and saving them to a text file. It is also possible to clear all the
fault records from both the tool and the protection relay and copy the fault records
either individually or all at once to a word processor.

5.6.2 Fault Record tool interface

Figure 75: Fault record tool
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Table 4: Available actions on the user interface

Action Description

Read Clicking Read reads all available fault records from the protection relay
into the tool. One fault record, 20 fault records or all fault records can be
read. The Read button opens up a progress bar to indicate an ongoing
read operation.

Clicking Cancel on the Read progress bar cancels the read operation. On
operation completion, the available fault records are shown in the record
grid.

Click the + icon to expand and view record details.

Clicking the + icon expands the record details for viewing.

Save Clicking Save saves the fault records on the local machine as .txt file.

Clear A record can be cleared from the Fault Record tool, the protection relay or
both. Before deleting the records, a confirmation dialog box is shown.

Close Clicking Close closes this instance of the Fault Record tool. All open
instances are closed when PCM600 is closed.

File File menu for Save and Exit actions.

Edit Copy All in the Edit menu allows to copy all the fault records which can
then be pasted to a word processor and saved on the local machine
without having to save the records as a .txt file.

Additionally the user can select any particular fault record and right-click
to copy the selected record.

5.7 IED Compare
IED Compare is used to compare the IED configurations of two IEDs of the
same type. It generates a text report which lists the differences between the IED
configurations. IED Compare provides an option to compare an IED configuration
stored in PCM600, IED or .pcmi file. IED Compare can compare certain types of IED
configurations and parameters.

• Application configuration
• Display configuration
• GOOSE receive configuration
• Parameters

Application comparison also compares the system function blocks.

Display comparison compares the LHMI page configurations.

Detailed instructions are shown in PCM600 documentation.
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5.7.1 Starting IED Compare
• Start IED Compare in the shortcut menu in plant structure.

a) In the PCM600 plant structure, right-click Substation, Voltage level, Bay or
IED.

b) Select IED Compare.
• Start IED Compare from the PCM600 main menu.

a) Select Substation, Voltage level, Bay or IED in the PCM600 plant structure.
b) On the PCM600 menu bar, point to Tools and select IED Compare.

5.7.2 IED Compare tool interface
The comparison report shows differences in the configuration of two IEDs.
Hardware, application, display, GOOSE and parameter configuration differences are
grouped and listed under the corresponding headings.

Figure 76: Compare options

Each configuration group can be expanded or collapsed by clicking the plus (+) or
minus (-) button next to it in the result grid.

The reports must be read from left to right row-wise.
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Figure 77: Compare report

Table 5: Acronyms used in a report

Acronym Description

DA Data attribute

DO Data object

IED Intelligent electronic device

LN Logical node

SIG Signal

5.8 Protection and control blocking examples
Test mode is selected through one common parameter via the HMI path Tests > IED
test. By default, Test mode can only be set locally through LHMI. Test mode is also
available via IEC 61850 communication (LD0.LLN0.Mod).

Table 6: Test mode

Test mode Description Protection BEH_BLK

Normal mode Normal operation FALSE

IED blocked Protection working as in Normal mode but
ACT configuration can be used to block phys-
ical outputs to process. Control function
commands are blocked.

TRUE

IED test Protection working as in Normal mode but
protection functions work in parallel with
test parameters.

FALSE

IED test and blocked Protection working as in Normal mode but
protection functions work in parallel with
test parameters. ACT configuration can be
used to block physical outputs to process.
Control function commands are blocked.

TRUE

The mode of all logical nodes located under the CTRL logical device is set
with Control mode. Control mode is selected via the HMI or PCM600 path
Configuration > Control > General. By default, Control mode can only be set
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locally through LHMI. Control mode inherits its value from Test mode but Control
mode ”On”, “Blocked” and “Off” can also be independently set. Control mode is also
available via IEC 61850 communication (CTRL.LLN0.Mod).

Table 7: Control mode

Control mode Description Control BEH_BLK

On Normal operation FALSE

Blocked Control function commands blocked TRUE

Off Control functions disabled FALSE

According to IEC 61850, the physical outputs to process should be blocked when
the device is set to blocked or test blocked mode. The blocking logic must be
implemented in the ACT configuration. In the protection blocking example the main
trip from TRPPTRC1 is blocked, and in the control blocking example CBXCBR1 is
blocked. Both comply with IEC 61850. In real applications some PTRCs might also be
used for signalling purposes (GOOSE) and blocking and interlocking via I/O.

5.8.1 Protection blocking example
The physical outputs to process can be blocked with “IED blocked” and “IED
test and blocked” modes. If physical outputs need to be blocked, the application
configuration must block the signals or the function blocks that affect primary
apparatuses. The blocking scheme needs to use the BEH_BLK output of the
PROTECTION function block.

TRPPTRC1
BLOCK
OPERATE
RST_LKOUT

TRIP
CL_LKOUT

Protection
BI_SG_2
BI_SG_3
BI_SG_4
BI_SG_5
BI_SG_6

SG_LOGIC_SEL
SG_1_ACT
SG_2_ACT
SG_3_ACT
SG_4_ACT
SG_5_ACT
SG_6_ACT
BEH_TEST

BEH_BLK

TRPPTRC1_TRIP

Figure 78: Master trip TRPPTRC blocked using Protection function block BEH_BLK
output

5.8.2 Control blocking example
The physical outputs to process can be blocked with “Blocked” mode. If physical
outputs need to be blocked, the application configuration must block signals or
function blocks that affect primary apparatuses. Blocking scheme needs to use
BEH_BLK output of CONTROL function block.
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Control

O:11|T:2,5|I:0

CTRL_OFF
CTRL_LOC
CTRL_STA
CTRL_REM
CTRL_ALL

OFF
LOCAL

STATION
REMOTE

ALL
BEH_TEST
BEH_BLK

CBXCBR1

O:13|T:2,5|I:1

POSOPEN
POSCLOSE
ENA_OPEN
ENA_CLOSE
BLK_OPEN
BLK_CLOSE
AU_OPEN
AU_CLOSE
TRIP
SYNC_OK
SYNC_ITL_BYP

SELECTED
EXE_OP
EXE_CL

OP_REQ
CL_REQ

OPENPOS
CLOSEPOS

OKPOS
OPEN_ENAD
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Figure 79: Circuit breaker control CBXCBR1 blocked using Protection function block BEH_BLK output
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6 HMI engineering

6.1 Graphical Display Editor
Graphical Display Editor is used to configure the protection relay's HMI pages.

Graphical Display Editor can be used to create new pages, configure pages by
adding widgets, set page visibility to different user categories, create single-line
diagrams and symbols and provide language translations.

6.1.1 Creating complete local HMI page configuration
• Configure the protection relay functions such as protection, measurements

and control functions with Application Configuration. The configuration made
in Application Configuration can be saved to make the interfaces and signals
available for other engineering tools within PCM600 such as Parameter Setting
or Graphical Display Editor.

• Make connections between the application configuration function blocks and
physical hardware inputs and outputs by using Signal Matrix or Application
Configuration.

• Configure HMI pages by using Graphical Display Editor. Create new pages,
configure the pages by adding widgets, set page visibility to different user
categories, create single-line diagrams shown on the LHMI and WHMI and
symbols, and provide language translations for the added LHMI elements.

1. To configure the single-line diagram, check if any new symbols are required
in addition to the default symbols in SLD Editor. Use Symbol Editor to create
the missing symbols.

2. Use SLD Editor to create a single-line diagram. Add bus bars, symbols and
texts and create links between the symbols. Link the dynamic symbols to the
corresponding function blocks in the application configuration. The function
blocks control the objects represented by symbols on the HMI. Add 10 SLD
pages at the maximum.

3. Use Page Organizer to configure the main screen of HMI and to create main
pages and linked pages by using the predefined ABB built-in pages and
template pages. Set also the page visibility to Basic or Advanced access
rights and define unique page names.

4. Use Page Editor to configure the main and linked pages and, for example, to
add widgets.

5. Use Language Translation to translate the configuration data text into
different languages. Configuration data includes widget properties, page
properties and symbol captions. If needed, add a new language from the
list of languages supported by the relay and set the translated text for the
language for available configuration.

6. Save the configuration.
7. Preview the configuration before writing it to the relay.
8. Write the configuration to the relay.
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6.1.2 Creating complete switchgear HMI configuration
• Configure HMI pages for all the relays that are intended to be connected to the

SHMI. These steps are described separately.
• Configure bay overview for each relay by using Graphical Display Editor. Create

SHMI pages, configure SLDViewPort or Image widgets, and create single-line
diagrams shown on the SHMI navigation page.

1. To configure a single-line diagram for the bay overview, create a single-
line diagram in Switchgear HMI SLD Editor. Create an SHMI page in Page
Organizer, add an SLDViewPort widget to the SHMI page, and select the
previously drawn SHMI SLD to be shown.

2. To configure an image for the bay overview, create an SHMI page in Page
Organizer. Add an Image widget to the SHMI page, and select the image to
be shown in the bay overview.

3. Save the configuration and write the bay overview configuration to the relay.
4. Close Graphical Display Editor.

• Create an SHMI object in the plant structure.
• Start Switchgear HMI Configuration from the SHMI object to configure the

navigation page for the SHMI.

1. Set the substation name, voltage level and switchgear name according to the
project requirements.

2. Ensure that all bay overviews under the Switchgear HMI Navigation Page
Configuration section are presented as intended in the SHMI navigation
page. The order of bays can be changed and any bay overviews unintended
for the SHMI can be moved to the Unallocated bays overview section.

3. Preview the navigation page to ensure that the result is correct.
• Set up a connection to the relays through a station network so that all the relays

are reachable.
• Write the SHMI configuration to all allocated relays.

6.1.3 ABB built-in pages
The ABB built-in pages contain information and functionality which are common to
most of the applications. Widget properties are usually fixed on these pages but
some, such as measurement page and phasors page contents, can be modified.

6.1.3.1 Measurements page
The Measurements page contains two configurable measurement lists. The buttons
at the bottom of the page are used to navigate to other measurement-related
pages: Phasors, Load Profile, Harmonics and Temperatures.

Only the Measurements and Phasors pages are user-configurable.

1MRS759117 D HMI engineering

REX640
Engineering Manual

99



Figure 80: Measurements page

The Measurements page configuration data is also used by the WHMI,
that is, even if the LHMI is not used with the relay, if the measurements
need to be seen on the WHMI, the Measurements page configuration
must be created in Graphical Display Editor.

Adding and removing measurements

1. In Page Editor, select the Measurements page and then select a measurement
list by clicking it.

2. In the Object Properties pane, click … on the listId row to browse the available
signals.

Figure 81: Accessing the signals

HMI engineering 1MRS759117 D

100 REX640
Engineering Manual



3. In the Signal Group Selection dialog, select check boxes to add the required
signals or clear them to remove any unused signals.

Figure 82: Selecting signals

4. Click OK.

Configuring measurement items

The measurement limits, scaling and order can be independently configured in the
Object Properties pane.

Click a measurement to select the measurement item. Then click the
same item again to select the measurement list.

• Set the measurement properties.

If the property value is set to "Automatic", the LHMI uses the value defined by the
data model.
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Figure 83: Configuring measurement items

• Apply custom scaling, if needed.

1. In the scaling box, define the correct value which is a coefficient applied
to the measurement value. The supported scaling is linear: new_value =
read_measurement_value × scaling_property + offset_property.

2. In the offset box, define the offset value.
3. In the unit box, define the unit (string).
4. Adjust the other limit properties to better fit the scaled measurement value.

• In the order box, define custom order for the measurements, if needed. The
smaller the order property, the higher the measurement's position in the
measurement list.

By default, all measurement list items are arranged in alphabetical order.
Modifying the order property overrides the default behavior.

6.1.3.2 Phasors page
By default, the Phasors page template available in Page Organizer contains an
empty Custom signal group. Measurements can be added to the Custom signal
group or new signal groups can be added and removed by opening the Phasors
page in Page Editor.

Opening Signal Grouping Editor

1. In Page Editor, open the Phasors page.
2.

Click  in the lower-right corner of the Phasors page.

The Signal Grouping Editor dialog opens.
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Figure 84: Opening Signal Grouping Editor

Adding and removing signal groups

• Add a new signal group.

1. In Signal Grouping Editor dialog, click Add.
2. In Enter Group Name dialog, type the signal group name.
3. Click OK.

Figure 85: Adding a signal group

• Remove an existing signal group.

1. In Signal Grouping Editor dialog, select a group from the Signal Group drop-
down list.

2. Click Remove.
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Figure 86: Removing a signal group

Adding and removing signals

• Add new signals.

1. In Signal Grouping Editor dialog, select a group from the Signal Group drop-
down list.

2. In List of All Signals list, select the required signals and click .

Add seven signals at the maximum to a single group.

3. Click OK.

Figure 87: Adding a signal

• Remove existing signals.

1. In Signal Grouping Editor dialog, select a group from the Signal Group drop-
down list.

2. Select the required signals and click .
3. Click OK.
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6.1.4 Page Organizer
Page Organizer is used for configuring the main screen of LHMI by creating main
pages, linked pages and switchgear HMI pages. Pages can be added, removed or
reordered in Page Organizer and, for example, their visibility can be set to "Basic" or
"Advanced". These access rights are mapped to user roles with User Management in
PCM600 and the pages are filtered based on the mapping. The selection "Basic" or
"Advanced" is not applicable to the WHMI. SHMI pages are used on the navigation
page of the SHMI.

In the Add Page dialog, some of the pages in the ABB Built-in Pages
category are marked with a padlock symbol. They are locked and cannot
be modified in Page Editor. If such a page should be modified, it can be
enabled by first saving it as a template.

Figure 88: Page Organizer

1MRS759117 D HMI engineering

REX640
Engineering Manual

105



6.1.4.1 Main pages and linked pages
Main pages can be navigated using the Home button on the LHMI. The main page
visibility is bound to access rights. Linked pages are pages which are linked from
other pages; they can be opened from a main page when a button is tapped.
Depending on the selected role, linked pages are shown under the main page area.

Both the main pages and the linked pages are defined in Page Organizer.

6.1.4.2 Templates
Templates allow replicating the same configuration with less effort. New pages can
be created by selecting a template page so that the new page becomes a new
instance of the template page. Templates also contain empty pages.

In Page Organizer, the ABB built-in pages are seen as page templates. Both ABB
built-in pages and template pages require unique names.

6.1.4.3 Creating pages
The relay supports 10 main pages, 20 linked pages and 2 SHMI pages at the
maximum.

1. In Page Organizer, create new pages in one of the alternative ways.

• Under Main Pages, click Add Page to create a main page.
• Under Linked Pages, click Add Page to create a linked page.

Change the page type (main or linked) by dragging the page from
one area to the other.

Figure 89: Adding pages
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2. In the Add Page dialog, select a predefined ABB built-in page or a template
page and click Add.

Define unique names for all main, linked and SHMI pages regardless
of their type.

Figure 90: Using ABB built-in pages or templates

6.1.4.4 Changing page order
• In Page Organizer, change the order of the pages by dragging a page to the

required place.
• Pages can also be dragged from Main Pages to Linked Pages and vice versa.

6.1.4.5 Creating templates
When a template is created out of an existing page, it becomes available under the
Templates section in the Add Page dialog. Templates allow replicating the same
configuration with less effort.

Save pages as templates in one of the alternative ways.

• Click Options in the upper-right corner of the page and select Save as Template
from the shortcut menu.

• Right-click the page and click Save as Template.
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Figure 91: Saving templates

6.1.5 Switchgear HMI Page Editor
Switchgear HMI Page Editor is used to configure the bay overview shown on the
SHMI navigation page. SHMI pages can be configured by adding widgets that are
the building blocks for configuring the bay overview. All the supported widgets are
populated in the Object Types pane.

Page Browser is shown at the bottom of Switchgear HMI Page Editor. It displays all
editable SHMI pages that are available in the Page Organizer. When a page is clicked,
it opens in Page Editor. Page templates are not shown in Page Browser.

Figure 92: Page with Image widget

6.1.5.1 Adding widgets
• Add a widget to the page by dragging it from the Object Types pane.
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• Set the widget properties.

Adding SLDViewPort

The SLDViewPort widget displays the single-line diagram configured in Switchgear
HMI SLD Editor. The single-line diagram is shown on the bay overview area of the
SHMI navigation page.

1. Drag the SLDViewPort widget from the Object Types pane to the page.
2. In Object Properties, select the required page from the page drop-down list.

Figure 93: Configuring the SLDViewPort widget

Adding Image

The Image widget displays a custom image on the bay overview area of the SHMI
navigation page.

1. Drag the Image widget from the Object Types pane to the page.
2. In Object Properties, select the required image from the file selection dialog.

Slicing of a photo or a static SLD picture for multiple bays should be done
in a separate editor application. Maximum size of the picture is 186 × 320
pixels.

6.1.6 Page Editor
Page Editor is used for configuring pages. Pages can be configured, for example, by
adding widgets that are the building blocks of the LHMI configuration or by creating
a single-line diagram.

Any graphical object drawn on the LHMI page is a widget. All the supported widgets
are populated in the Object Types pane.
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Page Browser is shown at the bottom of Page Editor. It displays all editable pages
selected for the Main Pages and Linked Pages categories in Page Organizer. When
a page is clicked, it opens in Page Editor. Page templates are not shown in Page
Browser.

Figure 94: Page with phasors

6.1.6.1 Adding widgets
• Add a widget to the page by dragging it from the Object Types pane.
• Set the widget properties.

Adding SLDViewPort

The SLDViewPort widget displays the single-line diagram configured in SLD Editor.

1. Drag the SLDViewPort widget from the Object Types pane to the page.
2. In Object Properties, select the required page from the page drop-down list.

Figure 95: Configuring the SLDViewPort widget
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Adding ViewPort

The ViewPort widget displays the contents of a page.

1. Drag the ViewPort widget from the Object Types pane to the page.
2. In Object Properties, select the required page from the page drop-down list.

6.1.6.2 Configuring pages
• Add new widgets by dragging them from Object Types to the page.
• Resize the selected widgets in one of the alternative ways.

- Click and hold any resize point on the edge or corner of the widget and drag
the mouse to resize the widget.

- Change the width and height properties of the widget in the Object
Properties pane.

• Set the properties of the selected widget by modifying the values in the Object
properties pane.

Once widgets are placed on the HMI page, some of them (Monitors) can be
linked to the corresponding function block in the application configuration by
using the source property. The values are updated by the protection relay either
periodically (measurement) or in case of an event.

Some of the widget properties can be in an automatic mode. When the property
is in the automatic mode, the values are set automatically by the protection
relay's LHMI. If a value is specified for an automatic property, the LHMI displays
the specified value.

Some of the widget properties cannot be edited as they are read-only
values.

• Group or ungroup multiple widgets regardless of their type.

Figure 96: Grouping widgets

When a group is created, all the individual widget properties such as the widget
name followed by the dot and the property name, are shown in the Object
Properties pane. Only properties x and y are common for all the widgets in the
group.

1MRS759117 D HMI engineering

REX640
Engineering Manual

111



The widget group property naming (aliases), visibility and read-only can be
modified.

The grouped widgets can be ungrouped by right-clicking the group and selecting
Ungroup.

• Bind the widget property values to the same or to another widget property
values or to signal values from the application configuration function.

It is possible to specify simple if...else conditions. The property values are then
changed based on those conditions.

For example, the LED color can be changed to red if the signal value is high or to
green if button2 is checked. Otherwise the LED color is yellow.

Figure 97: Binding property data

6.1.7 Symbol Editor
Symbol Editor is used to create symbols for a single-line diagram. It has different
drawing tools available such as line, rectangle and ellipse to draw the symbols.

6.1.7.1 Symbols
Symbols are used in the single-line diagram. Each symbol has at least one state that
represents the graphics of a symbol at different positions.

Symbol Editor supports three types of symbol standards. New symbols can only be
created under the custom standard.

• ANSI
• IEC
• Custom

Symbor Editor can be used to create dynamic symbols that have different states
corresponding to the different signal values supported by the symbol. For example,
the symbol states of a breaker (open, close, intermediate and faulty) can be
illustrated in Symbol Editor with the help of drawing tools such as line, rectangle,
ellipse, curve or polyline. The symbol State value should match the signal Enum
value. On the LHMI the symbols are displayed according to the signal value and the
matching symbol state value. One of the states is always the default state. Symbols
used in SLD Editor show the default state graphics.
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There are several options for the symbol size: 1x1 (normal size), 1x2 (height is
doubled), 2x1(width is doubled) and 2x2 (both the height and width are doubled).

Custom symbols can be exported from the Graphical Display Editor and reused in
other projects.

Figure 98: Symbol Editor

6.1.7.2 Creating custom symbols
New symbols can only be created under the custom standard. The available options
are the category, size and states. At least one state should be selected when
creating any symbol.

Before creating a new custom symbol, check that the states and category
required for the new symbol are available by default. Otherwise, it may be
necessary to create new states or categories.

1. Create a new symbol in one of the alternative ways.

• On the menu bar, point to Graphical Display Editor, point to Symbol Editor
and select Create Symbol.

• Right-click the symbol library and click Create Symbol.
•

On the toolbar, click .
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2. In the Create Symbol dialog, specify a name, category, size and states and click
Create.

Figure 99: Creating a new symbol

The new symbol becomes available in Symbol Editor with the states selected for
drawing. Different drawing tools such as line, rectangle and ellipse can be used
to draw the graphics for the different states.

3. Select the symbol state to be used as the default and set is default to True in
the Object Properties pane.

Figure 100: Setting the default state

4. Select the signals that should be connectable in SLD Editor via the symbol's
Signals property.
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a) On the menu bar, point to Graphical Display Editor, point to Symbol Editor,
point to Symbol and select Object Properties.

b) Select Signals property and click ....
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c) In the Signals Selection dialog, use  and  to add or remove
signals and click OK.

The connectable signal types for symbols are shown on the left side of the
Signal Selection dialog. Any signal type can be moved from the left side to
the right side and vice versa. These signal types are used to connect to the
symbol if the instance is available in the configuration.

Figure 101: Selecting the signals for a symbol



d) If the symbol is of control type, select the correct value in the control dialog
drop-down list.

Figure 102: Selecting the control dialog type

5. Save the symbol to make it available in SLD Editor.
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6.1.7.3 Creating categories
1. Create a new category in one of the alternative ways.

• On the menu bar, point to Graphical Display Editor, point to Symbol Editor
and select Create Category.

• Right-click the symbol library and click Create Category.
• On the toolbar, click .

Figure 103: Creating a category

2. In the Create Category dialog, specify a name and click Create.

6.1.7.4 Creating states
The symbol can have different states that represent the graphics for the symbol.
The symbol graphics are different for each state. The state is selected when
creating a new symbol.

1. Create a new state in one of the alternative ways.

• On the menu bar, point to Graphical Display Editor, point to Symbol Editor
and select Create State.

•
On the toolbar, click .

2. In the Create State dialog, select Create new state.
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3. Specify a name and numeric value and click Create.

Figure 104: Creating a state

6.1.8 SLD Editors
SLD editors are used to create single-line diagrams. In SLD editors, bus bars,
symbols and text can be added from the object type window and links can be
created between symbols. Graphical Display Editor has two separate editors.

• SLD Editor is used to draw single-line diagrams that are used on the normal HMI
pages.

• Switchgear HMI SLD Editor is used to draw a single-line diagram that is used on
the bay overview area of the SHMI.

Once the symbols are placed on the SLD page, they must be linked in Application
Configuration to the corresponding function block that protects or controls the
object represented by the symbol. The values are updated by the protection relay
either periodically (measurement) or in case of an event.

Single-line diagrams support both ANSI and IEC standards. Single-line diagrams
created in ANSI can be changed to IEC and vice versa by changing the symbol
standard in PCM600. Custom symbols can be used in both ANSI and IEC standards.
In the object type window, symbols are grouped by their category.

The single-line diagram created in SLD Editor can be used on the main pages with
a special widget called SLDViewPort. The widget is available under the Container
group and its page property populates the list of SLD pages. The single-line
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diagram size can be selected from the Object Properties pane. In ViewPort the
single-line diagram can be zoomed and paned on the LHMI.

Figure 105: SLD Editor

All SLD pages are shown at the bottom of SLD Editor. When a page is clicked, it
opens in SLD Editor. New SLD pages can be added by clicking the Add Page button.
To remove an SLD page, right-click the SLD page and select the Remove Page option
in the context menu.

The relay supports a maximum of 10 SLD pages.

SLD Page Editor is used for various tasks.

• Adding static text
• Adding measurands
• Adding bus bars
• Adding symbols to the display page
• Drawing lines (creating links)
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6.1.8.1 Adding bus bars
1. In SLD Editor, drag a BusBarHorizontal or BusBarVertical object from the

Object Types pane to the page view.

Figure 106: Adding a bus bar

2. Select the left or right connection point and drag it to increase the size of the
bus bar.

6.1.8.2 Managing bus bar coloring
Bus bar coloring is used to assign a color to a bus bar or links. New bus bar color
groups can be created and each color group can have one or more logic conditions;
each logic condition is associated with one color.

Apply the bus bar coloring

1. Right-click anywhere on the page and select Show Bus Bar Coloring.
2. In the SLD Logic Window dialog, click + to add a new color group or x to remove

an existing color group.
3. Expand any color group and click + to add IF and ELSE conditions and x to

remove them.
4. Click … to add another And condition inline. Click And to change or remove the

condition.
5. To add a value for a condition, click Value Button, select any signal value or

widget property value and press ENTER.
6. Select any color from the drop-down list.
7. Select Color Group and click on any bus bar to apply the coloring.
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Figure 107: Managing bus bar coloring

Remove the bus bar coloring

1. Right-click anywhere on the page and select Show Bus Bar Coloring.
2. Select any color group and click the bus bar to remove the bus bar coloring.

Bus bar coloring example based on the CBXCBR position value

If the CBXCBR position is open, all the bus bars and links associated with the “Color
Group1” group should be displayed in red color. If the CBXCBR position is closed, it
should be indicated in green color. Otherwise the color is black.

IF CBXCBR1:1. POSITION== open THEN Line Color is Red ELSE 
CBXCBR1:1. POSITION== closed THEN Line Color is Green ELSE Line 
Color is black.

Right-click anywhere on the page and select Highlight Conditional Bus
Bar to show bus bars that have the coloring applied.

6.1.8.3 Adding symbols to an SLD page
1. In SLD Editor, prepare the body of the single-line diagram by placing symbols to

the wanted positions on the page view.
2. Drag the apparatus or transformer symbols to the SLD Editor view.
3. Drag the connection symbols.
4. Place the junction points.
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5. Connect the symbols where necessary by drawing lines between the symbols'
source and destination ports.

Figure 108: Adding symbols to an SLD page

6. In the Object Properties pane, set the symbol properties.

• Use the x and y coordinates to adjust the placement of symbols in the
single-line diagram.

• Use controlState to define the default state of the symbol to be displayed in
the view.

• Use indicationOnly to define if the symbol is controllable (true = status only;
false = controllable).

• Use control to link the symbol to the function block in the application
configuration that protects or controls the object.

• Use stateColorMap to specify colors for the different states of the symbol.

Figure 109: Setting colors for the different symbol states
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If custom symbols have been used in the SLD configuration and then deleted, the
symbol graphics show an error and all the related connections are removed from the
configuration.

6.1.8.4 Creating SLD pages
1. On the Graphical Display Editor toolbar, select the symbol standard from the

drop-down list.

• IEC
• ANSI

2. Ensure that the Snap to grid and Show grid functions are available. These are
the default and recommended settings when designing a single-line diagram.

3. Place the primary equipment on the single-line diagram approximately in the
wanted position.

If required, rotate the symbols using the Rotate Left or Rotate Right functions.

4. Consider the necessary symbol connections, that is, links.
a) Click on the source port and click on the desired position to add a

connection point.
b) Draw a perpendicular line by moving the mouse while pressing SHIFT and

clicking on the target port.
5. Connect the symbols where necessary.

a) Move the mouse pointer over the symbol's connection ports.

The connection ports of all symbols are activated.
b) Drag the connection from the source connection port and drop it in the

target connection port.

A connection line between the source and target connection ports is drawn.

Alternatively, click on the source port and then click once at the target
port to create the connection. Move the mouse pointer on the nearest
connection port to ensure the target port. A “+” sign appears.

c) Right-click or press ESC to cancel the connection creation.

Once a link has been used to connect the symbols, the link follows the symbol
when it is moved to a new position or when it is rotated.

6. Move the mouse pointer away from the symbol's port for all the connection
ports of the symbols to become deactivated.

7. Select a symbol and modify its properties in the Object Properties pane.

The symbol name can also be changed by double-clicking the symbol.

8. In the Object Properties pane, use control to relate dynamic symbols to their
source data.

6.1.9 Language Translation
Language Translation is used to translate widget properties, page properties and
symbol captions into different languages. All the translatable properties, that is,
text properties, are displayed on the language translation tab.
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With Language Translation the users can add a new language from the list of
languages supported by the IED and set the translated text for the language. Once
the translations are written to the IED they can be displayed on the LHMI based on
the language selected.

Figure 110: Language selection

New languages can be added by clicking the Add Language button, selecting any
available language and clicking the OK button. The options Language 1...10 can be
used to specify a custom language.

PCM600 shows all the languages supported by the IED. When adding a new
language and writing it to the IED, it must be ensured that the corresponding
language binary is loaded in the IED and that the corresponding language pack for
the connectivity package is installed in the PC.

A warning message is displayed by the tool if the language binary is not
loaded in the IED.

6.1.10 Saving, reading and writing configuration to IED
1. Save the LHMI configuration in one of the alternative ways.

• On the File menu, select Save.
• Click the Save button on the toolbar.
• Press CTRL+S.
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2. To write the configuration to the IED, click the Write to IED button on the
toolbar.

This action must be confirmed before it is carried out, because it overwrites
the IED's existing display configuration. The writing operation can take a few
seconds or minutes to complete.

3. To read the configuration from the IED, click the Read from IED button on the
toolbar.

6.1.11 Previewing configuration
After the pages have been configured, the configuration can be previewed with a
soft LHMI before it is written to the IED. The soft LHMI is a Windows version of the
actual LHMI.

To launch the soft LHMI and to preview the configuration, click the Show Preview
button.

Figure 111: Launching the LHMI preview

6.1.12 Using HMI Client

REX640 HMI Client can be launched from PCM600. It connects to REX640 via
selected Communication Port and shows HMI view that is identical to actual
physical HMI.

HMI client can’t be paired with the REX640 and control operations are not possible.

1. Select context menu on the top of REX640 in plant structure using right click.
2. Select Browse with HMI > HMI Client. When connection is established “No

pages configured for the current user” is shown.
3. Click LOGIN on and enter credentials.
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4. HMI Client is showing the configured HMI pages.

Figure 112: HMI Client

6.1.13 GDE configuration export and import
The GDE configuration can be exported and then imported to any other IED.

6.1.13.1 Exporting GDE configuration
1. On the File menu, point to Display Editor Template and select Export.
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2. In the GDE Export dialog, select the pages, SLD pages, custom symbols and
translations to be exported.

Figure 113: Selecting objects for export

3. Click Export.

The selected items are exported in .pgdep format.

If the configuration contains custom symbols that are not selected, a warning
dialog is displayed.

4. Select the location to save the template and click Save.

6.1.13.2 Importing GDE configuration
1. On the File menu, point to Display Editor Template and select Import.
2. Click Browse to select any previously exported template file in .pgdep format

and click Open.
3. In the GDE Import dialog, select the pages, SLD pages, custom symbols and

translations to be imported.

• Items present in the current configuration have a green border.
• Items present in the current configuration with differences have a red

border.
• Items not present in the current configuration (new items) have a blue

border.
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Figure 114: Selecting objects for import

4. Click Import.

All page names must be unique. If a page is imported with a name that is
used by an existing page, a confirmation dialog is displayed. The options are to
overwrite the existing page, to create a new page with a different name or to
cancel the import.

Figure 115: Confirming action after name conflict

6.2 Switchgear HMI Configuration
Switchgear HMI Configuration is used to configure the SHMI navigation page after
the bay overview area has been configured for each relay using Graphical Display
Editor.

6.2.1 Configuring switchgear HMI navigation page
A maximum of 20 REX640 relays can be connected to one SHMI.
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1. In the Plant Structure, right-click a substation, a voltage level or a bay and point
to New, point to General and select SHMI to create an SHMI object.

Each SHMI object represents one SHMI in the installation.
2. Right-click the SHMI object and select Switchgear HMI Configuration.
3. Define Substation Name, Voltage Level and Switchgear Name to be shown on

the SHMI navigation page.
4. Drag the bay overviews to change their order, to allocate them for the SHMI or

to remove them from the SHMI.

All relays that support the SHMI are visible in the tool, and 20 relays are
automatically assigned to the SHMI. The unallocated bay overviews are available
to be assigned for other SHMIs in the project.

Figure 116: Allocating bay overviews to the switchgear HMI

5. Click Preview to test the result on the SHMI.
6. Click Write to write the SHMI configuration to all allocated relays.

Ensure that a connection is made to the relays through a station
network. All relays should be reachable in the network when the SHMI
configuration is written to the relays.

6.3 HMI Event Filtering
HMI Event Filtering is a tool that helps in configuring the visibility of the events
shown on the IED's LHMI and WHMI. This tool does not modify the actual events on
the protocol level.

The event visibility is modified in the event tree view. The events in the tree view are
structured in the same way as the functions in the PCM600 plant structure.
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Figure 117: HMI Event Filtering interface

6.3.1 Starting HMI Event Filtering
Start HMI Event Filtering in one of the alternative ways.

• Right-click an IED and select HMI Event Filtering.
• On the Tools menu, click HMI Event Filtering.

6.3.2 Setting visibility of HMI events
The event tree view is used to modify the visibility of the events shown on the LHMI
and WHMI. Events in the tree view are structured similarly to the functions in the
PCM600 plant structure.

1. Browse the event tree for the event.
Event nodes in the tree have more detailed description in the tool tip.
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2. Select or clear the check box next to the event name to specify its visibility.

Figure 118: Setting visibility of the HMI events

The event is visible on both LHMI and WHMI only when the check box is
selected.

Select the check box of the parent node in the event tree view to
modify the HMI visibility for multiple events.

Some events in the event tree are read-only and cannot be modified. The read-
only events appear dimmed on the user interface.

Figure 119: Read-only events are dimmed

6.3.3 Saving event filter configuration
Save the event filter configuration in one of the alternative ways.

• On the File menu, select Save.
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• Click Save on the toolbar.

The Save button on the toolbar is activated when the configuration is modified.

6.4 User defined names
PCM600 has a feature to set user defined names for signals, function blocks
and hardware channels. Functions and signals where setting user defined name
is supported are having blue color in application configuration tool. These user
defined names are used in different PCM600 tool components and on HMI to ease
identification of function or signal usage.

In PCM600 Application Configuration tool user defined name can be set by selecting
Set User Defined Name from context menu, or by editing User Defined Name
property in Object Properties pane.

User defined names are not shown on REX640 HMI and Web HMI by default. User
must enable them by setting parameter Configuration > HMI > User defined name.
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Figure 120: Example how user defined names are shown in events view and menu
structure

6.5 Alarm configuration
The HMI supports two alarm handling approaches.

• Alarm list
• Programmable LEDs

The alarm list approach uses event configuration to elevate an event to an alarm.
The programmable LEDs approach is similar to the traditional programmable LEDs
where instead of a physical LED, a virtual LED user interface element is used.

Programmable LEDs have three different presentation methods in the user
interface.

• Programmable LEDs page
• Virtual Alarm LED widget
• Alarm Annunciator full-page widget

Programmable LEDs page is available in ABB Built-in Pages category in the Page
Organizer. Programmable LEDs page automatically shows configured LEDs and
alarm texts. Page has buttons for clearing LEDs and resetting trips.

Virtual Alarm LED widget is single programmable LED. It can be added on any
operator page on HMI and it shows status and alarm text for configured LED. There
are also button widgets available for clearing LEDs and resetting trips.

Alarm annunciator is full page widget where user configures up to 64 alarms. Alarms
are presented in groups containing up to 16 alarms each.
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6.5.1 Alarm list
HMI Event Filtering in PCM600 is used to configure the event visibility on the LHMI
and WHMI. Any visible event can be configured as an alarm. See Chapter 6.3.2
Setting visibility of HMI events.

6.5.1.1 Elevating events to alarms
Alarm configuration is done in the HMI Alarm and Fault Selection view. Any visible
events can be elevated to an alarm or priority alarm. An alarm configuration text can
also be added to describe the alarm context.

Events can be grouped into a fault (group of selected events) on the LHMI and WHMI
event list. Grouping of events as a fault starts when any of the events selected in the
Fault column is activated and ends when all the events selected in the Fault column
are deactivated.

The group of selected events is shown as a Fault Events row on the event list. Each
event is visible by expanding this row.

1. Browse the HMI Alarm and Fault Selection view to find the event to be
configured as an alarm.

The event rows in the data grid view have more detailed description in the tool
tip.

2. Select or clear the check box in the Alarm column to elevate an event to an
alarm.

The event is visible as an alarm on both LHMI and WHMI only when the check
box is selected.

3. Select or clear the check box in the Priority column to elevate an event to a
priority alarm.

When the check box is selected, the event is visible as a priority alarm on both
LHMI and WHMI. The priority alarm is always the topmost in the alarm list. If the
check box is cleared, the event is visible as a normal alarm on both LHMI and
WHMI if the alarm check box is selected.

4. Select or clear the check box in the Fault column to create an event group on the
HMI event list.

When the check box is selected, the event in question (if activated) is included
in a fault.
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5. In the Alarm Configuration Text column, write some text to describe an alarm
context.

Figure 121: Elevating events to alarms

The alarm configuration text can be specified only if an event is
elevated to an alarm.

Select the check box in the column header of a column in the
data grid view to modify the alarm configuration, priority or fault
selection of all events.

6.5.1.2 Searching for events and alarms
In HMI Event Filtering, locate an event or alarm in the event filtering or alarm
selection views in one of the alternative ways.

• Use the predefined search strings.
• Type a search string manually.

6.5.1.3 Saving HMI alarm and fault selection
Save the HMI alarm and fault selection in one of the alternative ways.

• On the File menu, select Save.
• Click Save on the toolbar.

The Save button on the toolbar is activated when the configuration is modified.

6.5.2 Virtual programmable LEDs

6.5.2.1 Configuring LEDs in application configuration
Three steps must be completed to enable programmable LEDs in the relay’s HMI.

1. Instantiate LED functions in application configuration and connect the OK and
ALARM signals in application configuration.
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2. Configure LED description texts in Parameter Setting. Parameters are in IED
Configuration > Configuration > Programmable LEDs.

3. Clear all events elevated as alarms in HMI Event Filtering so that the HMI Home
button LED can follow the programmable LED state instead of the alarm list.

6.5.2.2 Configuring Programmable LEDs page
1. Open Page Organizer in Graphical Display Editor.
2. Select Add Page… on Main Pages section.
3. Select Programmable LEDs from ABB Built-in Pages section.
4. Select Add to insert programmable LED page to operator pages.

6.5.2.3 Configuring Virtual Alarm LED widget
1. Open Page Editor in Graphical Display Editor.
2. Drag and drop VirtualAlarmLed widget on the page.
3. Keep LED widget active and select LED1…LED66 in Object Properties pane’s

source property.

6.5.2.4 Configuring Alarm Annunciator page
1. Open Page Organizer in Graphical Display Editor.
2. Select Add Page… on Main Pages section.
3. Select Blank Page from Templates section.
4. Open Page Editor, and drag and drop Alarm Annunciator widget on the empty

page.
5.

Select  in the lower-right corner of the alarm annunciator page to open
function grouping editor.

6. Select Add to create new group.
7. Activate one of the created groups and select Local HMI/LEDx in the list of

available functions.
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8.
Select  to add LED to alarm group.

Figure 122: Function grouping editor and 4 configured groups

9. Select Save to close the editor.
10. Activate Short description area for one of the LEDs and type description that is

always visible on the annunciator page.

Description can be split on three lines.

Figure 123: Editor for short description in the alarm annunciator page
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11. Activate Long description for one of the LEDs and type description that
becomes visible when alarm is tapped on HMI page.

Figure 124: Editor for long description in the alarm annunciator page
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7 IEC 61850 communication engineering

7.1 IEC 61850 protocol references and pre-conditions
To engineer the IEC 61850 protocol interface for the protection relay, the following
additional manuals or knowledge of their contents is required.

• Knowledge of the IEC 61850 engineering process as described in the IEC 61850
standard

• The technical manual describes the function blocks defined as logical nodes
• IEC 61850 engineering guide
• IEC 61850 conformance documents for the protection relay to be engineered
• IEC 61850 parameter list

7.2 IEC 61850 interface
For more information on the implementation of IEC 61850 in protection
relays, see IEC 61850 engineering guide and conformance documents.
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7.2.1 IEC 61850 interface in the protection relay
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Figure 125: IEC 61850 communication interface principle

IEC 61850 provides a method for identifying all signals that belong to a function.
These signals are identified through the logical nodes representing the functions.
All signal information for relay parameters, settings, control and monitoring are
available in logical nodes.

Whenever a function block is instantiated in Application Configuration, PCM600
automatically generates the corresponding logical node data.

7.2.1.1 GOOSE data exchange
The IEC 61850 protocol supports a method to directly exchange data between two
or more devices (IEDs). This method is described in the IEC 61850-7-2 clause 15.

The concept is based on sending a multicast over Ethernet. The receiver detects
the telegram by its multicast destination address and application identifier, and
decodes the telegram for further processing by the application.
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Figure 126: IEC 61850: Horizontal communication principle, an example of three IEDs
where each IED communicates with all others

When a GOOSE message is to sent, it is defined by configuring the data set with
the defined trigger option and GoCB. This engineering process is done in a station
configuration tool, for example, IEC 61850 Configuration tool or IET600. The task
involves configuring lists with the signal, value and quality (data attributes or data
objects) that belong to the GOOSE message data set.

In the opposite direction, the standard only defines the IED as a receiver of a GOOSE
message. How the GOOSE input signals are handled must be defined in the device's
application configuration. The SCL data generated by the IEC 61850 Configuration
tool or IET600 (or any other station configuration tool) contains the GOOSE data
sets as input data. The input data must be connected to a GOOSE receive function
blocks in the Signal Matrix tool.

In the opposite direction, the standard only defines the IED as a receiver of a GOOSE
message. How the GOOSE input signals are handled must be defined in the device's
application configuration. The SCL data generated by the IEC 61850 Configuration
tool or IET600 (or any other station configuration tool) contains the GOOSE data
sets as input data. The input data must be connected to a GOOSE receive function
block in Signal Matrix.

7.2.2 Function view for IEC 61850 in PCM600
The IED design is directly based on IEC 61850. Thus, the function blocks in PCM600
use IEC 61850 logical node naming for function blocks. This relation is automatically
handled by the PCM600 tools.

In the IED, the IEC 61850 data for each function instance is available in the data
model, even when the function is not used in the application. This means that it is
not necessary to handle any instance information for the functions regarding IEC
61850.
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7.2.3 Station configuration description file types
The IEC 61850 standard defines SCL file types in the engineering sequence. These
files have a different definition, which is explained in IEC 61850-6. Three of the file
types are used in the IED's engineering process.

• ICD = IED capability description

Capability description of the IED in logical nodes and their data. No information
about, for example, the communication configuration is included.

An IED is already extended by default data sets and report control blocks. They
are predefined by ABB. Changes or additional data sets, for example, are handled
with IEC 61850 Configuration tool or IET600.

 
• SCD = Station configuration description

A complete configuration description of all IEDs in a station and the full
engineering of the process signals and communication structure is included. This
includes all the needed data sets and control blocks.

 
• CID = Configured IED description

The CID file contains the information needed for configuring one specific IED.
The CID file contains the complete configuration description of the IED: the
configured IED name, communication part, data sets and all control blocks.

 
• IID = Instantiated IED description

The IID file contains a complete IED configuration, like the CID file. The IID file can
include references to other devices which are not present in the file. The IID file
is meant for transferring configuration data from the IED configuration tool to a
system configuration tool.

7.3 IEC 61850 engineering process
The IEC 61850 standard defines how information is communicated in a substation.
The information communication can be divided into different parts.

• Description of the substation part, including the used logical nodes
• Description of the IEDs with their logical nodes
• Description of the communication network
• Description of the engineering process

When exporting an SCL file from PCM600, the tool builds a default substation
structure and creates default data sets and control blocks for vertical
communication between the substation client and IEDs. For more information, see
the IEC 61850 standards.

In the following example, it is assumed that PCM600 and IET600 are used as the
system configuration tools. Another option is to use IEC 61850 Configuration tool
or Application Configuration in PCM600. In that case, the SCL file export and import
(steps 1 and 3) are not needed. For more information on the GOOSE engineering
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in IEC 61850 Configuration tool and Application Configuration, see the IEC 61850
engineering guide.

1. SCL files are exported from PCM600. In this case, a SCD file. It is also possible to
export other SCL file types.

2. Horizontal and vertical communication is configured using the station
configuration tool, for example, IEC 61850 Configuration tool or IET600.

3. SCL files are imported to a PCM600 project. In this case, it is the updated SCD
file.

SCD file

 do IED engineering
 export SCD file

PCM600  (1)

 create project
 import SCD file
 configure data sets
 configure Report CBs
 configure GOOSE CBs
 export SCD file

  IET 600   (2)

 import SCD file
 link GOOSE input data
 Write to IED

PCM600  (3)

SCD file

IED 1 IED nIED 2 IED n -1

Figure 127: IEC 61850: signal engineering procedure flow when a complete station is
exported as a SCD file

7.3.1 Exporting SCL files from PCM600
A pre-condition for exporting SCL files from PCM600 is that all IEDs in the project
must be engineered in PCM600. The IEDs require a unique name and IP addresses
and they must be set according to the project definitions. IED configurations must
be finalized as far as possible before starting the IEC 61850 configuration part.

7.3.1.1 Exporting SCD files
1. In the Plant Structure view, right-click the substation and select Export.

IEC08000415.vsd

Station

Figure 128: IEC 61850: selecting the substation

2. In the Export dialog box, select the location to store the file and name it.
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3. Click Save.
4. In the SCL Export Options dialog box, click Advanced to change the SCL file

version if required by the receiving configuration tool.

Figure 129: Selecting the SCL file version

5. Click Export to generate the SCD file.

A progress window shows the ongoing export of the station.

7.3.1.2 Exporting ICD or CID files
1. Select the IED in the Plant Structure view.
2. Right-click the IED and select Export.
3. In the Export dialog box, from the Save as type list, select the type of file to

export.

- Configured IED description (.cid) for the IEC 61850 structure as needed for
the IED at runtime

- IED capability description (.icd) for the IEC 61850 structure

IEC08000416.vsd

Figure 130: IEC 61850: Selecting the IED file type for export

4. Click Save.
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5. In the SCL Export Options dialog box, select the export options.

Figure 131: IEC 61850: Selecting the export options

6. Click Advanced to change the SCL file version if required by the receiving
configuration tool.

Figure 132: Selecting the SCL file version

7. Click Export.

7.3.2 Engineering vertical and horizontal communication
For IEC 61850 engineering a separate system configuration tool needs to be
used with PCM600. The recommended tool for smaller projects is the IEC 61850
Configuration tool. For larger projects it is recommended to use IET600, which is
available as a standalone tool.

1. Create a project in IET600. 1
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2. Import the SCD file created by PCM600. 1

3. Conduct vertical communication engineering (monitoring direction).
a) Check the default data sets.
b) Configure the default data sets.

Data sets meant for vertical reporting can only contain data on
the data object level, not on the data attribute level.

The data set for GOOSE can contain signals on the data attribute
or data object level. Data object level GOOSE entries can only be
received of the following CDC types: SPS, SPC, ACD, ACT, DPS,
DPC, INC, INS, ENC and ENS.

c) Configure additional Report Control Blocks when needed for each data set
used for vertical communication.

d) Link the IED clients to the Report Control Blocks.

Up to five report clients can be configured.

4. Conduct horizontal communication engineering.
a) Configure GOOSE control blocks for each data set configured for GOOSE

messages.

One data can be included in the GOOSE data set only once.

b) Define the client IEDs for each GOOSE control block.
c) Link the IEDs to the GOOSE control block that must receive the GOOSE

control block.
5. Export the updated SCD file. 1

All data sets, Report Control Blocks and GOOSE control blocks must
be located in LLN0.

7.3.3 Importing SCL files to PCM600
The IED engineering tool must be able to receive an SCD file or an ICD file as an
import to receive the engineered communication extensions, for example, for the
different IEDs.

To be able to import an SCD file at station level, the option IED 61850 configuration
engineering mode enabled has to be cleared in PCM600.

1. On the Tools menu, select Options and click IEC 61850 Configuration.

1 Applicable when using IET600
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2. On the Engineering tab, clear the option IED 61850 configuration engineering
mode enabled and click OK.

Figure 133: Enabling SCD file import at station level

If the IED 61850 configuration engineering mode is enabled, SCD files
cannot be imported and an error message is shown.

Figure 134: Error message when SCD files cannot be imported

7.3.3.1 Importing SCD files
To be able to import an SCD file at substation level, the option IED 61850
configuration engineering mode enabled has to be cleared in PCM600.

1. In the Plant Structure view, right-click the substation and select Import.
2. On the Import dialog box, select the file to be imported.
3. In the SCL Import Options dialog box, select how to handle the file during the

import.
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Figure 135: SCL Import Options

• Click Don't import IEDs of unknown type to protect the existing IEDs in case
the SCD file does not match the original configuration in PCM600.

• Click Replace unknown if the file includes additional IEDs that are needed.
The IED of type “Generic IEC 61850 IED” is used to integrate this kind of IEDs
into the plant structure, for example.

• Click Ignore PCM Object Type to update the IED object(s) in PCM600 from
the IED type(s) in the SCD file, whether or not the IED type(s) in the SCD file
matches the IED object(s) in PCM600. This option can be used, for example,
when third party IEDs are included in the system and the SCD file sends
GOOSE messages to ABB IEDs included in the project.

• Click Ignore Substation Section to not import the SSD file part of the SCD
file.

4. Click Import when the file definition has been completed.
A progress view displays the importing procedure.

5. Make connections from the sending IEDs to the receiving function blocks with
the Signal Matrix.
Make connections between the signals that the server is send and the function
blocks on the receiver's side.
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6. Write the configuration to the IED.

In the Plant Structure view, select the IED, right-click and select Write to IED.

Figure 136: Write to IED menu

The engineered data is written to the IED when executing a common
Write to IED operation.

7.3.3.2 Importing ICD or CID files
1. Select an existing IED.
2. From the Files of type list, select the IEC 61850 file type to be imported (ICD or

CID).
3. In the SCL Import Option dialog box, select how the file is to be handled during

the import.

1MRS759117 D IEC 61850 communication engineering

REX640
Engineering Manual

149



Figure 137: SCL Import Options

• Don't import protects the existing IEDs if the SCD file does not match the
original configuration in PCM600.

• Replace unknown can be used when the file includes additional IEDs that are
needed. The IED of type “Generic IEC 61850 IED” is used to integrate this
kind of IEDs into, for example, the plant structure.

• Ignore PCM Object Type updates the IED objects in PCM600 from the IED
types in the SCD file, whether or not the IED types in the SCD file match the
IED objects in PM600.

• Ignore Substation Section does not import the SSD file part of the SCD file.
4. Click Import when the definition has been completed.

A progress view displays the importing procedure.
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7.3.4 Writing communication configuration to IED

IEC 61850 communication depends on the proper communication configuration in
all IEDs that communicate via IEC 61850.

It is possible to make a configuration change in one IED, without affecting the
horizontal communication (GOOSE or IEC 61850-9-2 LE) engineering between IEDs.
For example, when the Application Configuration tool configuration is changed, but
no changes are done to the instantiation or deletion of functions that represent a
logical node.

When a changed configuration is written to the IED, the horizontal communication
configuration needs to be updated.

Figure 138: Updating the communication configuration in the IED with the
configuration made in PCM600

1. Select which configuration part to include in writing.

• Select GOOSE to update the GOOSE configuration part in the IED.
• Select Process bus (IEC 61850-9-2) to update the IEC 61850-9-2

configuration part in the IED.

The options can be left unselected. In this case, other parts of the
configuration are updated.

2. Select whether or not to update the configuration.

• Click Continue to update the selected communication configuration parts in
the IED.

• Click Cancel to cancel the writing operation.
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8 Flexible product naming

8.1 IEC 61850 Structure Mapping
IEC 61850 Structure Mapping is used to manage the IED's data model as required.
This is done by mapping the data model to the customer-specific data model. IEC
61850 Structure Mapping is available only in FPN projects in PCM600. A PCM600
project can be converted into an FPN project by importing an FPN SCD file into it.
FPN is supported for both IEC 61850 Edition 1 and IEC 61850 Edition 2.

FPN allows the use of standardized, predefined and IED vendor independent
templates for building and maintaining substations. See the PCM600
documentation for more information about FPN.

8.1.1 User interface

Figure 139: IEC 61850 Structure Mapping

Plant structure

The data tree displays the FPN IEDs under substation and internal IEDs under
unassigned IEDs.

IEC 61850 structure mapping

The IEC 61850 structure mapping list displays the FPN objects based on the current
selection in the plant structure. The list may display either IEDs or data attributes.
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The FPN object’s name is displayed in the column on the left and the mapped
PCM600 internal object name is displayed in the column on the right. The customer
data structure and attributes are on the left, and the internal data structure and
attributes are on the right.

Object properties

The Object Properties pane displays the properties of the objects selected in the
FPN mappings and Internal Data Attribute lists.

8.1.2 IED and signal naming convention
The names used for the internal objects can be defined to be either the names used
in PCM600 or the names in the internal IEC 61850 model.

To change the naming convention, select the PCM600 naming style in use
from Options.
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8.2 Importing substation configuration description file
The SCD file can be imported only at the substation level.

1. On the Tools menu, click Options.
a) Select Flexible Product Naming. In the General tab, select Import as

Flexible Product Naming SCD option enabled.
b) Select IEC 61850 Configuration. In the Engineering tab, clear the IEC 61850

configuration engineering model enabled check box.
c) Click OK.

Figure 140: Enabling the FPN option

2. Right-click a substation level, and then click Import.
3. Browse and select the SCD file.
4. Click Open to open the file.
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5. Select Import as Flexible Product Naming SCD.

Figure 141: Importing as Flexible Product Naming SCD

The imported SCD file changes the substation structure. The internal IED from
the original substation structure is replaced and pushed to the unassigned IEDs
folder.

Figure 142: Unassigned IEDs
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6. Drag the unassigned IED over the internal IED.

Figure 143: Assigned IED

Importing the FPN SCD file converts the project into an FPN project.
The conversion is irreversible.

FPN projects do not support configuring GOOSE with Application
Configuration.

8.3 Starting IEC 61850 Structure Mapping
The tool can be started from any node from the substation to IED level.

1. Right-click one of the IEDs and point to Flexible Product Naming.
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2. Click IEC 61850 Structure Mapping.

The FPN object’s name is displayed in the column on the left and the name of
the mapped PCM600 internal object is displayed in the column on the right.

Figure 144: Flexible product naming tool

8.4 IEC 61850 structure mapping

8.4.1 IED mapping
The first step in the IEC 61850 structure mapping is to map the real IEDs to the
customer-specific IEDs. IED mapping means that each server IED in the FPN model
is mapped with a corresponding IED in the internal PCM600 model, that is, the real
device in the substation. A server IED is an IED that has an access point containing a
server. IED mapping does not map the data attributes between the IEDs unless the
data attribute mapping is complete. IED mapping can be done in the PCM600 plant
structure and in IEC 61850 Structure Mapping.
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8.4.1.1 Mapping IED in PCM600 plant structure
• To map the IED in the plant structure, drag a PCM600 IED from the Unassigned

IEDs group onto an FPN IED in the substation.

IED mapping status is indicated visually in the plant structure.
• To remove an IED mapping from the plant structure, drag a mapped FPN IED

onto the Unassigned IEDs group.

The removed mapping is indicated visually in the plant structure. The PCM600
internal IED, with which the FPN IED was mapped, appears back in the
Unassigned IEDs group if it is not mapped with any FPN IEDs.

8.4.1.2 IED mapping in IEC 61850 Structure Mapping

IED mapping

The tool displays all FPN IEDs and all PCM600 IEDs in separate lists. Mapping is
done by dragging the PCM600 IED on the right-hand side to an FPN IED on the
lefthand side. The tool indicates the mapping status visually. The mapping needs to
be saved to apply it.

Figure 145: Mapping of IEDs in IEC 61850 Structure Mapping

Removing IED mapping

Removing IED mapping is done in IEC 61850 Structure Mapping by right-clicking the
mapping and selecting the context menu option or pressing the DELETE key. The
tool indicates the mapping status visually. The change must be saved.

Access point mapping

Figure 146: Access point mapping
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Access point mapping defines the relations between REX640 internal access points
and customer access points.

In the above example, REX640 access point AP1 is in subnetwork WA1, while access
point AP2 is in subnetwork WA2. The configuration is created using Ethernet
configuration.

The network configuration must be correct before the flexible product
mapping is started.

REX640 supports one access point for data model. Second access point
AP2 is based on the ServerAt concept and has the same data model in
different IP addresses.

The REX640 access points are mapped to FPN project's access points IED1_AP1
and IED_AP2. The third access point IED1_AP2_UNDESIRED is excluded from the
mapping since it does not have a network interface.

Data tree view

The data tree view consists of customer data structure in the column on the left and
the name of the mapped PCM600 internal data structure in the column on the right.

Figure 147: Data tree view

Data attribute list view

The data attribute list view consists of customer data attributes in the column on
the left and the PCM600 internal data attributes in the column on the right.
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Figure 148: Data attribute list view

Filters

The displayed objects can be filtered using the filtering options on the quick access
toolbar.

Figure 149: Filters

Free text filter

The objects are filtered by free text, showing all the objects with a certain name in
both Data Structure level and Data Attribute level.

Show/hide objects by status

The objects are filtered by status, showing only the selected objects in Data
Structure level and Data Attribute level.

Enable and disable type filters

Objects in the FPN can be filtered using additional filtering options available in the
quick access menu.

8.4.2 Data attribute mapping
Data attribute mapping means that each FPN data attribute in the FPN model is
mapped to a corresponding data attribute in the internal PCM600 model, that is,
the real device in the substation.
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The mapping status is indicated visually. It can be seen what FPN data attribute is
mapped to what PCM600 internal data attribute and how many FPN data attributes
are mapped to a PCM600 internal data attribute.

Data attribute mapping is complete when all data attributes of the FPN IED, which
are not excluded from the mappings, are mapped to a PCM600 internal data
attribute. Data attribute mapping must be complete to be able to write to IED.

Data attribute mapping is broken if any of the mapped data attributes - FPN or
PCM600 internal - does not exist in the SCL database.

Table 8: Visual indication of the mapping status

Icon Description

Completely mapped

Not mapped

Broken mapping

Partially mapped

Excluded from mappings

All data attributes in the FPN model must be mapped or excluded,
otherwise write to IED fails.

8.4.2.1 Mapping data attribute level
IEC 61850 Structure Mapping displays the FPN data attributes and PCM600 internal
data attributes in separate lists.

• To map data attributes, drag the FPN data attribute onto a PCM600 internal data
attribute.

• Remove a data attribute mapping in one of the alternative ways.

• Right-click the mapping and select the remove option.
• Select the mapping and press the DELETE key.
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Figure 150: Data attribute level mapping

8.4.2.2 Mapping data object level
Create data attribute mapping on the data object level in one of the alternative
ways.

• Drag a data object from the customer data structure onto a data object in the
internal data structure.

• Drag a data object from the internal data structure onto a data object in the
customer data structure.
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Figure 151: Completed data object mapping

8.4.2.3 Mapping logical node level
Create data attribute mapping on the logical node level in one of the alternative
ways.

• Drag a logical node from the customer data structure onto a logical node in the
internal data structure.

• Drag a logical node from the internal data structure onto a logical node in the
customer data structure.

1MRS759117 D Flexible product naming

REX640
Engineering Manual

163



Figure 152: Logical node level mapping

8.4.2.4 Excluding data attributes from mapping
Exclude the data attributes in one of the alternative ways.

• Select the data attributes to exclude, right-click and select Exclude Items.

Figure 153: Excluding data attributes from mapping

• Exclude all unmapped data attributes from the data object at once by right-
clicking the data object and selecting Exclude Data Attributes.
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Figure 154: Excluding data attributes from mapping

The data attributes that are excluded from the mapping are not excluded from
the model. Excluded mappings are ignored when determining if an IED mapping is
complete.

It is crucial to set a value to the excluded data attributes before initiating
the mapping.

8.5 Setting data attribute value
Edit the Value field in the Object Properties pane.

• For enum type of data attributes, select the value from the list of available values.
• For numeric and string type of data attributes, type the value in the Value field.
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Figure 155: Setting the data attribute value

A value cannot be set for all data attributes types. For example, quality
and timestamp values cannot be edited.

8.6 Validation
Once the FPN mapping is complete, all mapping can be validated in three ways
using the validate options available on the toolbar.

Figure 156: Validate mapping

Flexible product naming 1MRS759117 D

166 REX640
Engineering Manual



8.7 Template creation
It is possible to create a template of an IED’s data attribute mapping and store it for
reuse. The template contains the description of the data attribute mapping of two
IED SCL models.

All mapping templates created in PCM600 are stored in a template library. The
template library is not specific to a certain PCM600 project, but it is common for all
projects. Templates in the library can be managed in several ways.

• Delete selected templates
• Export templates: One or multiple template files can be exported.
• Import templates: One or multiple template files can be imported. If a template

being imported already exists in the library, the user is asked whether to
overwrite the existing one.

• Export project’s templates: When a PCM600 project is exported, all templates
used in the project are automatically included in the exported .pcmp file.

• Import project’s templates: When a PCM600 project is imported, all templates
included in the imported .pcmp file are automatically imported into the template
library. If a template being imported already exists in the library, it overwrites the
template in the library.

The mapping templates are also used by IET600 to translate the internal data
references in the signal library to the FPN references, because IET600 needs to know
what template to use to resolve the internal data references.

Create a template for each IED mapping.

8.7.1 Mapping template creation
Data attribute mapping templates can be created from mapped IEDs. If the
template is created from an incompletely mapped IED, a dialog box is shown. The
user can select an option to not show the dialog box again. The dialog box can be
activated afterwards from the PCM600's Options menu.

The template can be created either from IEC 61850 Structure Mapping or from the
PCM600 plant structure. The required template information must be filled in before
it can be created.

8.7.2 Applying of a mapping template to IED
The template can be selected from a list of available templates. The FPN IED must
be mapped with a PCM600 internal IED before the template can be applied.

The template can be applied either in IEC 61850 Structure Mapping or in the
PCM600 plant structure. In IEC 61850 Structure Mapping, the template can be
applied to one or several IEDs at once. In the plant structure, the template can be
applied on one IED at a time by right-clicking an IED, or on all IEDs under a bay by
right-clicking the bay.
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8.7.3 Exporting FPN templates
1. Right-click the PCM600 plant structure.
2. Point to Flexible Product Naming and select Manage Mapping Templates.
3. Select the templates to export and click Export.

Figure 157: Exporting FPN templates

4. Select the folder where to export the templates and click OK.

8.7.4 Reporting and printing
The report consists of a cross-reference list of the IED and data attribute mappings,
that is, a table of all FPN objects together with the PCM600 internal objects they are
mapped with.

Figure 158: IED mappings

Figure 159: Access point mappings
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Figure 160: Data attribute mappings
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9 Glossary

ACT 1. Application configuration tool in PCM600

2. Trip status in IEC 61850

AIM Analog input module

ANSI American national standards institute

ARP Address resolution protocol

CID Configured IED description

CMT Communication management tool in PCM600

COM600S Substation management unit. An all-in-one communication gateway, au-
tomation platform and user interface solution for utility and industrial
distribution substations.

COMTRADE Common format for transient data exchange for power systems. Defined
by the IEEE standard.

Connectivity
package

A collection of software and information related to a specific protection
and control IED, providing system products and tools to connect and
interact with the IED.

DA Data attribute

Data attribute Defines the name, format, range of possible values and representation of
values while being communicated

DHCP Dynamic host configuration protocol

DO Data object

EMC Electromagnetic compatibility

Ethernet A standard for connecting a family of frame-based computer networking
technologies into a LAN.

FPN Flexible product naming

FTP File transfer protocol

FTPS FTP Secure

GCB 1. GOOSE control block

2. Generator circuit breaker

GDE Graphical display editor in PCM600

GoCB GOOSE control block

GOOSE Generic object-oriented substation event

HMI Human-machine interface

HSR High-availability seamless redundancy

HTTPS Hypertext transfer protocol secure

HW Hardware

I/O Input/output

ICD IED capability description

Table continues on the next page
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IEC International electrotechnical commission

IEC 61850 International standard for substation communication and modeling

IEC 61850-9-2 A communication protocol based on the IEC 61850 standard series

IED Intelligent electronic device

IET600 Integrated engineering toolbox

IID Instantiated IED description

Instance Identical protection function blocks available in a standard configuration.
By setting the application-specific parameters of an instance, a protec-
tion function stage can be established.

IP Internet protocol

IP address A set of four numbers between 0 and 255, separated by periods. Each
server connected to the Internet is assigned a unique IP address that
specifies the location for the TCP/IP protocol.

LAN Local area network

LED Light-emitting diode

LHMI Local human-machine interface

LN Logical node

MAC Media access control

NCC Network control center

PC 1. Personal computer

2. Polycarbonate

PCM600 Protection and control IED manager

PRP Parallel redundancy protocol

PST Parameter setting tool in PCM600

RTD Resistance temperature detector

SAB600 Substation automation builder tool

SCD Substation configuration description

SCL XML-based system configuration description language defined by IEC
61850

SLD Single-line diagram

SMT Signal matrix tool in PCM600

SMV Sampled measured values

Subnet mask A set of four numbers used to create IP address numbers that are used
only within a particular network, subnet

VPN Virtual private network

WAN Wide area network

WHMI Web human-machine interface

Widget Any graphical object drawn on the LHMI page with Page Editor in
PCM600

XRIO eXtended relay interface by OMICRON
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